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User’s Guide to Planetary Image Analysis and Geologic 
Mapping in ArcGIS Pro

Sarah R. Black

Background
Geologic maps are valuable tools in planetary science. Though planetary geologic maps are similar to terrestrial (Earth-

based) geologic maps, the nature of planetary exploration introduces unique challenges for geologic mappers. Terrestrial 
geologic mappers prepare products from field-based observation, often comparing or refining those with aerial and (or) orbital 
images. Planetary geologic mapping relies almost exclusively on remote observations, which are made by orbiting spacecraft. 
Therefore, with a few exceptions for locations with rovers, landers, or crewed surface missions, planetary geologic mappers are 
not able to observe their map area in detail or at smaller scales. As a result, they must interpret and describe their map features 
differently than those used in terrestrial geologic maps. For example, terrestrial geologic mappers commonly divide units by 
lithology (rock type) or grain size. However, planetary geologic mappers often do not have detailed enough information to know 
what type of rock or grain size is present, and instead must divide the planet’s surface into geologic units using differences in 
tone, color, and surface texture (at multiple scales). Cross-cutting relationships, where apparent, can provide excellent—and 
often crucial—observations for identifying and subdividing geologic units using orbital datasets.

The process of creating planetary maps has evolved over time, from original hand-drawn maps created during the 
early 1800s through the late 1900s, to the fully digital products created today. Modern-day planetary geologic mapping uses 
Geographic Information Systems (GIS) software and tools to visualize data, delineate units and landforms, and accurately 
convey spatial relationships to a map user using cartographic features represented by points, lines, and polygons.

This tutorial was written to familiarize both new and experienced planetary geologic mappers with ArcGIS Pro, a commonly 
used GIS software package developed by Esri. This tutorial introduces new planetary geologic mappers to fundamental concepts 
and best practices in planetary geologic mapping. For mappers with experience using ArcMap (a previous version of ArcGIS), 
this tutorial will help to familiarize users with new changes in layout and functionality, so current projects may be migrated into 
the ArcGIS Pro environment. No prior knowledge is required, although a general familiarity with geology, GIS, and planetary 
science is recommended. This tutorial includes links to helpful glossaries of common GIS terms and other GIS and planetary 
science resources in appendix 1. For additional information on planetary geologic mapping, see the U.S Geological Survey (USGS) 
Astrogeology NASA Planetary Geologic Mapping Program website and the Planetary Mapping Guidelines. Numerous ArcGIS 
tutorials are also available from Esri’s Tutorials page, through the Esri Academy catalog, and Esri’s ArcGIS Pro Resources page.

Learning Goals and Objectives

Exercise 1

Goal: Upon successful completion of this exercise, both new ArcGIS and experienced ArcMap users will be familiar with 
the ArcGIS Pro interface.

Objective: By the end of this exercise, users will be able to:
1.	 Navigate the dynamic menu bar, contents, catalog, and other tool panes.

2.	 Import existing ArcMap projects.

3.	 Change between layout and map views.

4.	 Create a new ArcGIS Pro project.

5.	 Add data to a project.

6.	 Adjust layer display properties.

7.	 Manage map and group layers within the Contents pane.

https://www.esri.com/en-us/arcgis/products/arcgis-pro/overview
https://www.esri.com/
https://www.usgs.gov/special-topics/planetary-geologic-mapping
https://www.usgs.gov/special-topics/planetary-geologic-mapping/current-planetary-mapping-guidelines
https://learn.arcgis.com/
https://www.esri.com/training/catalog/search/
https://www.esri.com/en-us/arcgis/products/arcgis-pro/resources
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Exercise 2

Goal: Upon successful completion of this exercise, both new ArcGIS and experienced ArcMap users will be able to use 
ArcGIS Pro to analyze raster data in a planetary science setting.

Objective: By the end of this exercise, users will be able to:
1.	 Create and work with mosaic datasets.

2.	 Understand the difference between raster functions and geoprocessing tools.

3.	 Use geoprocessing tools to complete a multi-step analysis.

4.	 Use raster functions to complete a multi-step analysis.

5.	 Create and use custom raster functions to complete a multi-step analysis.

Exercises 3, 4, and 5

Goal: Upon successful completion of these exercises, both new ArcGIS and experienced ArcMap users will be able to 
execute common planetary geologic mapping methods and observe best practices for planetary geologic mapping in ArcGIS Pro.

Objective: By the end of these exercises, users will be able to:
1.	 Create a new feature class.

2.	 Create and edit features within a feature class.

3.	 Create polygons from both point and linear features.

4.	 View and edit a feature class attribute table.

5.	 Edit symbologies both manually and using a symbology layer file.

6.	 Create and edit a complete map layout, including placing scale bars, a north arrow, and legend.

Required Files and Preparation
In addition to this document, the user will need to download the associated PlanetaryImageAnalysis.zip file, which 

contains all the GIS files needed to complete this tutorial. Both are available on the Tutorials page of the USGS Planetary 
Geologic Mapping Website. After downloading, unzip the PlanetaryImageAnalysis.zip file, and save the unzipped folder 
(PlanetaryImageAnalysis) to a location of your choice on your computer. You will be opening GIS files from this folder, so make 
sure you know where you have it saved.
Note: ArcGIS Pro is a Windows-based software. This tutorial is intended to be completed using a PC and ArcGIS Pro version 
2.6 or newer. Depending on your version of ArcGIS Pro, you may notice some slight variations in icons, and so forth.

https://www.usgs.gov/special-topics/planetary-geologic-mapping/planetary-mapping-and-gis-tutorials
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Exercise 1: Introduction to ArcGIS Pro
In this exercise you will learn the basics of the ArcGIS Pro interface, including how to create a new project and import 

preexisting projects in both .mxd (ArcMap) and .aprx (ArcGIS Pro) formats.
1.	 From your desktop or Start menu, open ArcGIS Pro

men22-7579_fig 02

Note: If you haven’t previously logged in, you will be prompted to do so at this point; this is how the licensing works for ArcGIS 
Pro. If you are not logged in, the software will not know you have a license and will not be able to run. If you need to be able to 
work offline, there is an option to check out a license for offline use in the ArcGIS Pro options. This is accessible to you after you 
log in for the first time. Often, the number of licenses that are available for offline use are limited in number, so be sure to check 
with your organization’s portal administrator before checking one of these out.

2.	 A new window will open for ArcGIS Pro with several options to set up a new map project. Select Start without a template.

men22-7579_fig 01
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Part 1: The ArcGIS Pro Interface

A new map project will open with a blank template. Before adding anything to this new project, take a few minutes to 
explore the ArcGIS Pro interface:

men22-7579_fig 01

Across the top of the window is the dynamic menu bar. The tabs that are currently displayed (Project, Map, Insert, 
Analysis, View, Edit, Imagery, and Share) are always visible. Additional tabs will appear as you select items in your project. The 
menu bar will only display tabs that you can currently use, depending on what type of item you have selected. For example, the 
raster formatting tabs will automatically appear when you have raster layers selected.

Down the left side of the window is the Contents pane. This is where the layers of data that are included in your map will 
be listed. Once data is added to your map, you will be able to view its symbology, attributes, and other information through this 
pane. You may also re-order layers within the Contents pane list to change how they are displayed relative to (above or below) 
each other in your map. You can adjust the width of the Contents pane by clicking and dragging the right side in and out.

On the right side of the window is the Catalog pane. The Catalog pane has three tabs that you can switch between at the 
top. From left to right, they are the Project, Portal, and Favorites tabs. The Project tab of the Catalog pane is where you can 
access all the various data sets, folders, and maps that you have connected to your project. The Portal tab connects you to items 
which you and others have hosted online. This includes items which are curated for use in Esri’s “ArcGIS Living Atlas of the 
World,” and any item that has been shared publicly or with your organization within ArcGIS Online. The Favorites tab is where 
you can find any dataset, folder, map, or other item that you have marked as a favorite. Favorites persist outside of your map 
projects, so this is a useful place to have datasets or folders which you may need to access often and do not want to have to 
reconnect to every time you create a new map project. As with the Contents pane, you can also adjust the width of the Catalog 
pane by clicking and dragging the left side in and out.

men22-7579_fig 01

https://livingatlas.arcgis.com/en/home/
https://livingatlas.arcgis.com/en/home/
https://www.arcgis.com/index.html
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Part 2: Import an Existing ArcMap Project

To begin, you will first import an existing map into your project. Often, you may find that you or a collaborator have a 
mapping project that already exists in ArcMap (.mxd file format), and you need to import it into ArcGIS Pro to continue your work.

3.	 In the Project section of the Insert tab (in the menu bar), click Import Map

men22-7579_fig 01

4.	 In the Import window, navigate to the PlanetaryImageAnalysis folder, which you unzipped earlier and saved to a 
location of your choice. Then double click the Exercise_1 folder to open it and select the Nili_75K_ArcMap10.6.mxd 
Map Document.

men22-7579_fig 01

5.	 Click OK to select and import the map.
You will notice this map has imported with the layout format displayed. When opening or importing a pre-existing map 

document, whether the layout or map view is displayed will depend on how that map document was last saved. (By default, 
new map documents will open in map view.) When maps are displayed in layout format, the individual map layers are no longer 
visible in the Contents pane. Instead, items like the scale bar, map legend, and additional labels are listed in the Contents pane.
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The original GIS map is still present in this file, you only need to access it. When you imported the map, the Catalog pane 
closed (this is not always the case and will also depend on how the ArcMap document was last saved).

6.	 To re-open the Catalog pane, select the View tab in the menu bar and click the Catalog pane icon.

men22-7579_fig 01

Note: This is where you may also re-open your Contents pane if it is ever closed.

The Catalog pane will once again be accessible on the right side of your project window. The original GIS map for this 
project will be listed under the Maps section of the Catalog pane.

7.	 Click on the small triangle to the right of the Maps icon in the Catalog pane to expand that section. You will see a map 
named Nili_75K listed.

8.	 Right click the Nili_75K map and select Open. You can also simply double click on the Nili_75k map to open it.
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The Nili_75K map will be added to your project as a new tab in the main window. The layout view is still present in 
another map tab. However, that is no longer needed.

9.	 Click the small x on the Nili_75K_ArcMap10.6 tab (located at the top of your active map window) to close the layout view.

men22-7579_fig 01

Note: You can still access the layout view if you need it. It will be listed in the Catalog pane under Layouts and can be re-opened 
the same way you opened the map in the previous steps.
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Part 3: Map Layers and the Dynamic Menu Bar

With the map now open, explore the map layers that are listed in the Contents pane. By default, the map layers are listed 
in drawing order, so items at the top of the list are sitting on top of the items below. This becomes important when it comes to 
making layers transparent and making sure that all features are clearly visible. You can drag map layers up and down within the 
Contents pane list to change their drawing order.

men22-7579_fig 01

10.	 This map contains several different types of layers. Click on the layers in the Contents pane and note how the tabs in 
the menu bar change as you select different types of layers.

men22-7579_fig 01

As you select different types of layers in the Contents pane, the menu bar will detect what type of data is present and will 
automatically display the appropriate tabs at the top of the screen. When vector layers (points, lines, and polygons) are selected, 
the Feature Layer tabs are displayed, as seen in the example above. When a raster layer (images and other datasets) is selected, 
the Raster Layer tabs are displayed. The first eight tabs (Project, Map, Insert, Analysis, View, Edit, Imagery, and Share) are 
always displayed.
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Part 4: Saving Your Map Project

11.	 To save your new map project, click on the small save icon in the upper left corner of the ArcGIS Pro window.

men22-7579_fig 01

12.	 Navigate to PlanetaryImageAnalysis\Exercise_1. This is where the original ArcMap document is, and where you 
will save your new ArcGIS Pro version.

men22-7579_fig 01

13.	 Name your Project Nili_75K_ArcGISPro and click Save.

14.	 In your Windows File Explorer, navigate to the PlanetaryImageAnalysis\Exercise_1 folder and observe the new file 
structure.

men22-7579_fig 01
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By default, when you save a new project in ArcGIS Pro, it will create a new folder in the directory where you assign the 
project to be saved. All project files will be saved into this folder.

15.	 Double click on the Nili_75K_ArcGISPro folder to open it and observe the file structure.

men22-7579_fig 01

All project files are located within the Nili_75K_ArcGISPro folder, including the ArcGIS Project File (.aprx). The .aprx 
file is the ArcGIS Pro equivalent to the ArcMap .mxd file type. If you wish to re-open this map project later, you can do so with 
the .aprx file. When saving a new ArcGIS Pro project, all the additional project files such as the default toolbox and default 
geodatabase (.gdb) are automatically created and saved in this same directory. (Note: .aprx files are not backwards compatible 
and can not be opened with ArcMap software.)

16.	 Return to the ArcGIS Pro window and exit from your map project by clicking the x in the upper right corner. You can 
return to this project at any time through the .aprx file you created in the previous step.

Summary

In this exercise you became familiar with the ArcGIS Pro interface and learned how to import pre-existing ArcMap 
projects. In some instances, imported map projects will open in layout display. In this exercise you learned how to use the 
Catalog pane to access both the layout and map displays within the ArcGIS Pro interface. You also explored the dynamic menu 
bar and observed how the menu bar tabs automatically update as you select different map layers and features. This allows the 
dynamic menu bar to only show you tools and tabs that you are currently able to use. As a final step, you saved the imported 
map project as a new ArcGIS Pro project file (.aprx) and observed the default file structure. When saving a new ArcGIS 
Pro project, the project file and all automatically generated associated files (such as the default toolbox and default project 
geodatabase) will automatically be saved in the designated folder. Once an ArcGIS Pro project has been created and saved, it can 
be reopened using the .aprx project file.

To Prepare for the Next Exercise

To prepare for Exercise 2, you will first need to exit this ArcGIS Pro project. Click the small x in the upper right corner of 
your ArcGIS Pro window to close it.
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Exercise 2: Working with Rasters
In this exercise, you will begin working within a new ArcGIS Pro project, rather than importing an existing ArcMap 

document. If you have not already done so, be sure to exit the ArcGIS Pro project from Exercise 1 before you begin.
1.	 In your Windows File Explorer, navigate to the PlanetaryImageAnalysis\Exercise_2 folder and double click the 

PlanetaryImageAnalysis_Exercise_2 project file (.aprx) to open it in ArcGIS Pro.
The PlanetaryImageAnalysis_Exercise_2 project will open in ArcGIS Pro. Data has not yet been added to the map, so the 

map tab will appear empty, and no map layers are listed in the Contents pane.
2.	 In the Catalog pane, click on the small triangle to expand the Folders section. You will see the 

PlanetaryImageAnalysis project folder listed. This is the home folder for your project. Click on the small triangle to 
expand the PlanetaryImageAnalysis folder and view its contents.

men22-7579_fig 01

Note: In the future, you may find times when you need to access a different folder that is not already present in the Catalog pane. 
To do this, right click the Folders heading in the Catalog pane and select Add Folder Connection. Navigate to the folder you 
wish to access, select it, and click OK to add it to the list.

Part 1: Adding Data and Working with Map Layers

To begin working with your map, you will need to add data.
3.	 In the Catalog pane, click on the small triangle to expand the Data section of the PlanetaryImageAnalysis folder. 

Then click on the small triangle to expand the Rasters folder and view its contents.

4.	 Right click on the Jezero_Orthomosaic.tif item and select Add to Current Map.
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The Jezero_Orthomosaic.tif image will be added to your map. You should now see the image displayed in the map 
window and see the map layer listed in the Contents pane.

men22-7579_fig 01 men22-7579_fig 01



Exercise 2: Working with Rasters    13

5.	 Click on the save icon  in the upper left corner or your ArcGIS Pro window to save your project. Do this often while 
you work. (Note: You will not be prompted again to save your work in this tutorial. Make sure you continue to do so.)

When working in a GIS, it is not uncommon to end up with many layers in your map. You can organize and group these 
layers in the Contents pane.

6.	 At the top of the Contents pane, right click Map and select New Group Layer.

men22-7579_fig 01

The New Group Layer is now listed at the top of your map contents.
7.	 In the Contents pane, click the New Group Layer and then hover over it to activate the text. Rename the group 

Rasters. Press enter to apply your changes.

men22-7579_fig 01
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8.	 Click and drag the Jezero_Orthomosaic.tif layer into the Rasters group. Then click on the small triangle next to the 
Rasters group to expand it and view its contents.

men22-7579_fig 01

You can click and drag map layers to move them in and out of the group layers at any time while you are working. In 
the future, if you wish to quickly group multiple map layers which are already present, you can use control+click to select the 
desired layers and then right click and choose Group. This will create a new group which automatically includes the selected 
layers.

For planetary mapping, it is typical to have two main group layers: one for rasters (base imagery and other pixel-based 
data); and one for the mapping features themselves, which are vector-based (points, lines, and polygons). You can also follow 
the same process as you did above to make additional groups within those if desired. Group layers are useful for keeping your 
data and map layers organized. Additionally, you can quickly collapse or expand entire groups to see their contents by clicking 
on the triangle next to the group layer name. You can also quickly turn all active (checked) group layers on or off by checking or 
unchecking the box next to the group layer name.

Part 2: Metadata

Robust GIS applications like ArcGIS Pro enable researchers to use, process, and integrate data from a variety of sources, 
often to create new products for further analysis. However, for data products to be usable by others, they must contain 
appropriate metadata. Metadata (data about data) is information which describes a dataset, including what it is, where it is, 
how it was created, how it was intended to be used, and who to contact with questions. There are a variety of ways to describe 
data, but in many instances the planetary science community has established standards for metadata content and encoding. This 
increases the likelihood (but does not guarantee) that each dataset will include the appropriate and necessary information for 
those who wish to work with it. Metadata standards also support more than human readability, which is often accomplished with 
README text files. They also enable machine-to-machine readability, which is what drives much of the interoperability of data 
across data long-term data archives like the NASA Planetary Data System (PDS) and other repositories like the NASA Solar 
System Treks platform. Supporting machine-to-machine readability also supports analyses through machine learning, artificial 
intelligence, and other applications and tools. In short, good metadata makes it so you and others can find and make sense of 
existing datasets. Without appropriate metadata, datasets may not be findable or usable.

The Jezero_Orthomosaic.tif image you are viewing in your map was created by the USGS Astrogeology Science Center 
for the Mars 2020 Perseverance rover Terrain Relative Navigation (TRN) team. This orthomosaic was made using images from 
the Mars Reconnaissance Orbiter’s Context Camera (CTX) and is one of the highest-accuracy images ever created of Mars, 
with a horizontal accuracy of 9.6 meters (m) (each pixel in this image represents 6 m on the ground). The corresponding High 
Resolution Imaging Science Experiment (HiRISE) TRN orthomosaic has a horizontal accuracy of 1.1 m and a resolution of 25 
centimeters per pixel (cm/pixel). These high levels of accuracy were necessary because these images were used by the Mars 
2020 rover’s TRN analysis to automatically (and successfully) identify a safe place to land in Jezero crater. Here, you will 
explore the metadata that is attached to the CTX orthomosaic of Jezero crater using the ArcGIS Pro interface. If desired, you can 
also explore the metadata for the HiRISE orthomosaic at the link above.

https://pds.nasa.gov/
https://trek.nasa.gov/
https://trek.nasa.gov/
https://astrogeology.usgs.gov/search/map/Mars/Mars2020/JEZ_hirise_soc_006_orthoMosaic_25cm_Eqc_latTs0_lon0_first
https://astrogeology.usgs.gov/search/map/Mars/Mars2020/JEZ_hirise_soc_006_orthoMosaic_25cm_Eqc_latTs0_lon0_first
https://science.nasa.gov/technology/technology-highlights/terrain-relative-navigation-landing-between-the-hazards
https://science.nasa.gov/technology/technology-highlights/terrain-relative-navigation-landing-between-the-hazards
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9.	 In the Contents pane, right-click on Jezero_Orthomosaic.tif layer and select View Metadata.

men22-7579_fig 01

This will open a new Catalog tab in the main viewing area of the ArcGIS Pro interface. The Catalog tab contains a list of 
your map layers on the left, and item metadata on the right.

men22-7579_fig 01
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10.	 Take a minute to read through the metadata that is provided for the Jezero_Orthomosaic.tif image to get a sense of 
what is often included in this supporting information. When you have finished, click on the small x in the Catalog tab 
to close it and return to your map.
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To learn more about working with and creating your own metadata, see appendix 2.

Part 3: Projections

Map projections are mathematical equations for transforming a three-dimensional (3D) body onto a two-dimensional (2D) 
plane or Cartesian (X, Y linear distance-based) coordinate system. All modern GIS applications use these defined Cartesian 
systems as the underlying method to geolocate or accurately position all data sets. It is also the key to how GIS applications 
provide their spatial analysis capabilities like determining the length or orientation of a line to calculating the safest path for a 
rover to traverse across the landscape.
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Subset of the U.S. Geological 
Survey Map Projections poster 
showing the Miller cylindrical 
projection. Image Credit: U.S. 
Geological Survey, 2007, Map 
projections: U.S Geological 
Survey Poster, 2 sheets, at 
https://www.usgs.gov/media/
files/map-projections-poster.

GIS applications continue to get better at hiding the complications for using map projections. When the data is properly 
defined, once loaded into ArcGIS Pro the data will automatically be correctly positioned to match the projection that is assigned 
to the map itself—even when every loaded dataset may be defined using a unique map projection. One of the most significant 
challenges in planetary versus terrestrial mapping is that local coordinate systems are not established, so users must often create 
their own custom projections based on the latitude, extent, and scale of the map. To learn about more advanced map projection 
issues and techniques, see appendix 3.

ArcGIS Pro supports real-time on-the-fly transformations which allows a user to overlay data sets defined using different 
map projections. But a critical first step in any ArcGIS Pro project is to make sure the projection of the map frame itself is 
correctly set. Fortunately, when starting with an empty map frame, ArcGIS Pro will inherit the map projection from the first 
loaded layer. In this case, the first layer you added to the map was the Jezero_Orthomosaic.tif image.

11.	 In the Contents pane, right click on the title for the map frame (by default this is named “Map”) and select 
Properties. In the Map Properties window, select the Coordinate Systems tab.
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The map frame has inherited the projection from the Jezero_Orthomosaic.tif layer (called Equirectangular_Mars_2000_
Sphere_IAU). If you wanted to change the map frame projection, you could do so here by searching for Mars in the Search bar 
and selecting a different option. With the map frame correctly set for your project, you can load additional data sets, and all of 
them should project on-the-fly (when needed). If a data set does not correctly project when added to the map, it is likely that the 
data set’s map projection is undefined or incorrectly defined.

Tip: When adding the first layer to a new map, always pick the data set that you trust the most and (or) is defined in the map 
projection you wish to work in. ArcGIS Pro now comes with many tools that can accurately calculate lengths, areas, and 
orientations (angles) for your defined collected features data sets by using geodesic calculations. That means regardless of 
the map projection (and the potential errors incurred by that map projection), it will accurately calculate those measures. For 
example, within the Add Geometry Attributes geoprocessing tool, you will find options to calculate geodesic area and lengths. 
However, for these measurements to be useful, you must start with an accurately (and appropriately) defined map projection.

While you are in the Map Properties window, you can also change how the coordinate units are displayed. This does 
not change how the data is projected, it only affects how the cursor location coordinates are displayed at the bottom of your 
map window (for example, converting from projected meters to degrees). By default, the coordinate display will always show 
positive east longitudes.

12.	 In the Map Properties window, click on the General tab. Then click on the Display units dropdown menu and 
observe the options that are available. End with Decimal Degrees selected.
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13.	 Click OK to exit the Map Properties window and return to your map.
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Part 4: Modifying Display Properties

There may be times when you need to adjust how your raster image or data is displayed. You can do this using the tools in 
the Raster Layer Appearance tab.

14.	 In the Contents pane, click on the Jezero_Orthomosaic.tif layer to select it. With this layer selected, the Raster 
Layer tabs (Appearance and Data) are now visible in the menu bar at the top of your screen. Select the Raster Layer 
Appearance tab to view the tools that are available.
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In the Raster Layer Appearance tab, you can change several layer properties. This includes common tasks such as setting 
a visibility range (scales at which the layer will turn on or off as you zoom in and out), adjusting the transparency, accessing 
the symbology settings, and changing the stretch, brightness, and contrast.

15.	 In the Rendering section of the Raster Layer Appearance tab, select the Stretch Type dropdown menu and choose 
a different stretch type. Experiment with different stretches to see how they compare. When you are done, return to 
the Percent Clip stretch. Additional details regarding each of these stretch options and how they work are available 
through Esri at their ArcGIS Pro Resources page.
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https://pro.arcgis.com/en/pro-app/latest/help/data/imagery/raster-display-ribbon.htm
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Another option for the stretch is to turn on the DRA (Dynamic Range Adjustment) setting. By default, stretches are applied 
using the range of pixel values for the entire raster, regardless of whether you are viewing the whole raster or a small section of 
it. When DRA is turned on, the stretch is automatically adjusted as you zoom and pan and will only use the values of the pixels 
within your current display extent (the area you are viewing at that moment).

16.	 In the Navigate section of the Map tab, make sure the Explore icon is selected. It should already be highlighted in 
blue as a default. If it is not, click on it to select it.
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With the Explore tool selected, you can use your mouse to pan around the map and use the scroll wheel of the mouse to 
zoom in and out.

17.	 In the Rendering section of the Raster Layer Appearance tab, click the DRA icon to turn this setting on. Then 
explore your image and see how the stretch changes as you zoom in and out and pan around the scene. When you are 
done, click the DRA icon again to turn this setting off.
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DRA can be helpful in picking out more subtle variations and small-scale details that may be lost when the stretch is 
applied using the entire raster. However, using the DRA setting is not always appropriate—it will depend on what you are doing 
and the data you are viewing. Knowing whether DRA will be helpful or not usually involves experimentation with the specific 
dataset(s) with which you are working.

18.	 In the Contents pane, right click on the Jezero_Orthomosaic.tif layer and select Zoom to Layer to return to the full 
extent of this layer.

In the Raster Layer Appearance tab, you can also manually adjust the Brightness and Contrast for your whole layer.
19.	 In the Enhancement section of the Raster Layer Appearance tab, move the Brightness  and Contrast  slider bars up 

and down to see how those change your image. When you have finished, click on the Brightness and Contrast icons 
to the left of the slider bars to reset the values to their starting points.
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Part 5: Mosaic Datasets

For these exercises, you will be working with a larger area than is covered by the Jezero_Orthomosaic.tif image. Instead, 
you will use multiple tiles of imagery from the Mars Reconnaissance Orbiter Context Camera (CTX). When working with sets 
of images, it is often beneficial to put those images in a mosaic dataset. A mosaic dataset is a single layer in your map, which 
contains a collection of images that can be analyzed and manipulated as one. Individual images within a mosaic dataset can also 
be queried and added to your map individually, allowing you to work seamlessly with anything from one individual image, to 
hundreds of images at once.

You will begin by creating the mosaic dataset item. Once the mosaic dataset has been created, you can then add images and 
edit its properties.

20.	 In the Catalog pane, click on the small triangle next to the PlanetaryImageAnalysis\Exercise_2 folder to 
expand and view its contents. Then click on the small triangle next to the PlanetaryImageAnalysis_Exercise_2.
gdb (geodatabase) to expand it. The PlanetaryImageAnalysis_Exercise_2 geodatabase is located in the 
PlanetaryImageAnalysis\Exercise_2 folder.
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When you begin a new project from scratch, your geodatabase is empty. In this case, two items: the Mars2020_Landing_
Ellipse feature class, and the Jezero_Mapping_Practice feature dataset have already been added to your project geodatabase. 
You will add additional items to it as you work. The project geodatabase is where you can store both raster and vector features 
for your map. Storing map features in a geodatabase allows you to easily share them with collaborators.

21.	 In the Catalog pane, right click the PlanetaryImageAnalysis_Exercise_2 geodatabase and select New → Mosaic 
Dataset.

https://mars.nasa.gov/mro/mission/instruments/ctx/
https://pro.arcgis.com/en/pro-app/latest/help/data/imagery/mosaic-datasets.htm
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The Create Mosaic Dataset tool will open in the Geoprocessing pane.
22.	 Set the following inputs in the Create Mosaic Dataset tool:

Output Location: PlanetaryImageAnalysis_Exercise_2.gdb (this is already set as the default)

Mosaic Dataset Name: CTX_mosaic

Coordinate System: Current map [Map] (Note: the coordinate system will automatically populate when you select 
this option)

Product Definition: None

23.	 Expand the Pixel Properties section of the Create Mosaic Dataset tool and set the following inputs:

Number of Bands: 1

Pixel Type: 8-bit unsigned
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Note: The Pixel type is based on the images you will be adding to the mosaic dataset. This information can be found by right 
clicking in the Catalog pane on one of the images you will be using and selecting Properties. The pixel type is described under 
Raster Information in the Pixel Type and Pixel Depth.
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24.	 Click Run to create your new mosaic dataset.
Once the Create Mosaic Dataset tool has completed, you will see a green message box at the bottom of the 

Geoprocessing pane.
25.	 Click on the Catalog tab at the bottom of the Geoprocessing pane to return to the Catalog pane.
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The new mosaic dataset (CTX_mosaic) will now be listed in the Catalog pane under the PlanetaryImageAnalysis_
Exercise_2 geodatabase.
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The mosaic dataset (CTX_mosaic) has also been automatically added to your map and is now listed in the Contents pane.
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26.	 In the Contents pane, click on the CTX_mosaic layer and drag it into the Rasters group, on top of the Jezero_
orthomosaic.tif layer.
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27.	 In the Contents pane, quickly collapse the CTX_mosaic and Jezero_Orthomosaic.tif by holding the control key and 
clicking on the small triangle next to the CTX_mosaic layer name. (Note: the control+click also works to expand all 
layers in a list at once)

28.	 In the Contents pane, uncheck the box next to the Jezero_Orthomosaic.tif layer to turn it off.
With the Jezero_Orthomosaic.tif layer turned off, all that should be visible in your map is the CTX_mosaic layer.

29.	 In the Contents pane, right click the CTX_mosaic layer and select Zoom to Layer. This will make sure you are in the 
correct place to view it.

men22-7579_fig 01
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When you zoom to the CTX_mosaic layer, you will notice there are no images visible. This is because the Create Mosaic 
Dataset tool only creates an initial mosaic dataset file. The new mosaic dataset file is empty and must have images added to it.

30.	 In the Catalog pane, right click the CTX_mosaic item in the PlanetaryImageAnalysis_Exercise_2 geodatabase and 
select Add Rasters.
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31.	 In the Add Rasters To Mosaic Dataset tool, leave the defaults unchanged and click on the small Browse icon  under 
Input Data.

men22-7579_fig 01
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32.	 Navigate to PlanetaryImageAnalysis\Data\Rasters and select the four Murray-Lab_CTX .tif files (and only the .tif 
files). Use control+click to select multiple files at once. (Note: You may have to change the display option from “File 
List (*.csv)” to “All files (*.*)” in the bottom right corner of the Input Data window.)
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33.	 Click Open to add these to the Input Data list.

men22-7579_fig 01
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34.	 In the Add Rasters To Mosaic Dataset tool, expand the Raster Processing section and check the boxes to Calculate 
Statistics and Build Raster Pyramids.
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35.	 Click Run to add the CTX images to your mosaic dataset.
Once the Add Rasters To Mosaic Dataset tool has completed, you will see four small green boxes in your map window. 

These are the footprints of the CTX images you just added to the CTX_mosaic layer.
36.	 Use the scroll wheel of your mouse to zoom in to the four green footprints in your map window. As you zoom in you 

will eventually see the images appear within the footprints.
The images within your mosaic dataset are only displaying when you zoom in because you have not yet created overviews. 

Overviews are lower resolution versions of the image that will display when zoomed out. Using overviews improves the 
rendering speed of your map and is easier for your computer to display compared to the higher resolution images which have 
unnecessary levels of detail at those scales.

37.	 Click the Catalog tab located at the bottom of the Add Rasters To Mosaic Dataset Geoprocessing pane to return to 
the Catalog pane.

38.	 In the Catalog pane, right click the CTX_mosaic item in the PlanetaryImageAnalysis_Exercise_2 geodatabase and 
select Optimize → Build Overviews



28    User’s Guide to Planetary Image Analysis and Geologic Mapping in ArcGIS Pro

men22-7579_fig 01

39.	 In the Build Overviews tool pane, leave all defaults, and click Run to create the overviews for your mosaic dataset.

40.	 Once the Build Overviews tool is complete, zoom out in the map window. You should now be able to see the images 
in CTX_mosaic layer even when zoomed out.

41.	 Now that you have confirmed your overviews were successfully created, click on the small x in the upper right corner 
of the Build Overviews tool to close it and return to the Catalog pane.

men22-7579_fig 01
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42.	 In the Contents pane, click on the small triangle next to the CTX_mosaic layer to expand it. Then uncheck the 
Footprint box to turn the footprints off. Click on the small triangle next to the CTX_mosaic layer name again to 
collapse the layer details.

With the footprints turned off, all that should be visible now is a seamless mosaic of CTX images.
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43.	 In the Contents pane, right click the CTX_mosaic layer and select Zoom to Layer to zoom back to its full extent.
One of the benefits of working with mosaic datasets is that you can quickly and easily work with many images as though 

they were one.
44.	 In the Contents pane, select the CTX_mosaic layer. This will activate the Mosaic Layer tabs in the menu bar.

45.	 In the Mosaic Layer Appearance tab, experiment with the Stretch, Brightness, and Contrast as you did earlier. Note 
how this affects all the images in your mosaic dataset instead of just working with a single image. When you have 
finished, return the Stretch to Percent Clip, and the Brightness and Contrast to 0.

46.	 Click on the Mosaic Layer Data tab in the menu bar to explore the tools that are available for this type of data.
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When working with a mosaic dataset, you may want to search for specific images within your collection. You can do this 
using the Explore Raster Items tool.

47.	 In the Selection section of the Mosaic Layer Data tab, click on the Explore Raster Items tool.
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48.	 In the Raster Item Explorer pane, change the By Area Of Interest dropdown menu to Display Extent, and check the 
box to Exclude Overviews. Then click Apply. This will search for and display all the images that are included in the 
mosaic dataset, as long as they are within your current display. By checking the box to exclude overviews, the explorer 
will only return a list of the original images, and not the original images and each of their overviews.
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The Raster Item Explorer list now contains the four original CTX images you added to the mosaic dataset. 
49.	 Click on the Configure Results  icon in the toolbar at the top of the list and check the box to Show Thumbnails. In 

the second dropdown list, change the selection from AcquisitionDate to Name. Then click Apply.
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The individual CTX images in the Raster Item Explorer list are now shown with thumbnails and the file names. 
Configuring how the results are displayed can make it easier to explore your mosaic dataset items. If you were working with 
data that had other identifying information, you could use the Configure Results selections to show those as well.

From the Raster Item Explorer list, you can also add individual images to your map. This is often helpful if you have a 
large collection of images and only need to work with one or a few of them.

50.	 In the Raster Item Explorer list, hover over individual images to see the icons that appear.
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The Add to Current Map  icon is available for each mosaic dataset item. You can click this icon to add any individual 
image to your map. To add multiple images to the map, check the box in the upper right corner of the mosaic dataset items you 
want to add, and then click the Add to Current Map icon in the toolbar at the top of the list.
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For this exercise, you will be working with the whole mosaic dataset and do not need to add any individual images to the map.
51.	 Click on the small x in the upper right corner of the Raster Item Explorer pane to close that tool and return to the 

Catalog pane.
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Part 6: Modifying Symbology

Often in planetary science, you will work with Digital Elevation/Terrain Models (DEMs/DTMs). DTMs can provide 
valuable insight into a region and are frequently used for analyses such as the landing site suitability assessment you will 
complete in Exercise 4. For this analysis, you will use a subset of the Syrtis DTM, which uses a blend of the European Space 
Agency’s High Resolution Stereo Camera (HRSC) and NASA’s Mars Orbiter Laser Altimeter (MOLA) elevation data.

52.	 In the Catalog pane, right click on the syrtis_dtm raster (located under Folders → PlanetaryImageAnalysis → Data 
→ Rasters) and select Add to Current Map.
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https://astrogeology.usgs.gov/search/map/Mars/Topography/HRSC_MOLA_Blend/Mars_HRSC_MOLA_BlendDEM_Global_200mp_v2
https://www.esa.int/Science_Exploration/Space_Science/Mars_Express/Mars_Express_instruments
https://attic.gsfc.nasa.gov/mola/
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The syrtis_dtm will be added to your map as a new layer.
53.	 In the Contents pane, click on the syrtis_dtm layer you just added and hover over the name to enable editing. Rename 

this map layer to Syrtis DTM and press enter to apply the changes. Often datasets will come with names that are 
not intuitive. You can rename any map layer within the Contents pane for clarity (the “alias”), without changing the 
original file names. (Note: When working in ArcGIS, actual file names can not include spaces. However, file aliases 
may include spaces)

54.	 In the Contents pane, click on the Syrtis DTM layer and drag it into the Rasters group, on top of the CTX_mosaic layer.
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55.	 With the Syrtis DTM set to 0% transparency, the base images are not visible. In the Effects section of the Raster 
Layer Appearance tab, set the Syrtis DTM layer transparency to 60%
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The Syrtis DTM layer is now transparent, and the underlying base imagery is visible. However, the current DTM 
symbology is set to grayscale and is not useful for visualization.

56.	 In the Contents pane, right click the Syrtis DTM layer and select Symbology.
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This will open the Symbology pane. The Symbology pane is where you can change the symbol type, color, stretches, and 
many other options.

57.	 In the Symbology pane, open the Color scheme dropdown menu and check the boxes for Show names and Show all.
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58.	 Scroll down through the available color schemes and select Heat Map 3.
This is a preset color scheme, but it can be further modified within the Symbology pane.

59.	 Open the Color scheme dropdown menu again and select Format color scheme at the bottom.
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60.	 Explore the Color Scheme Editor options and change the color scheme to anything of your choosing. (Note: This is 
not the color scheme you will be using later, so do not worry about messing something up.)

A.	 Select different colors by selecting a pointer  and changing the color in the Color dropdown box.

B.	 Delete and add different color marker points by clicking the + and x in the upper right corner.

C.	 Experiment with moving the pointers along the color ramp to change how the colors are distributed.

D.	 Flip the color ramp so the order is reversed. 

61.	 Once you have finished experimenting with the Color Scheme Editor, click OK to apply your changes. You should 
now see the new Syrtis DTM symbology displayed in the map.
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Note: Colors will vary dramatically depending on the changes you made.

Now that you have had a chance to experiment with making a custom color scheme, you will set the actual color scheme 
for your Syrtis DTM layer.

62.	 Open the Color scheme dropdown menu again and select Cividis.

Colorblind-friendly color schemes: Many commonly used color schemes are not colorblind-friendly. For this tutorial, 
you will use the Cividis color scheme, which is a blue to yellow color ramp. If needed, feel free to choose a different color 
scheme which best suits your visual needs. If desired, you can use the ColorBrewer Schemes (RGB, red-green-blue) style 
to identify colorblind-friendly schemes. To do this, in the Catalog pane, click on the small triangle to expand the Styles 
section. Then right click the ColorBrewer Schemes (RGB) style and select Manage to open this style in the Catalog view. 
In the Search Project box (upper right), search for “color blind” to return a list of colorblind-friendly color schemes. 
You can then select the colorblind-friendly color scheme of your choice in the Symbology pane. When you have finished, 
click on the small x in the Catalog view tab to close it and return to your map.
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Helpful tip: Before exiting the Symbology menu, take a moment to explore the Mask tab in the 
bottom section. Often, images have a black border or background that needs to be removed so 
they can be displayed top of other images. The Symbology Mask tab is where you can remove 
this background.

In future projects, if an image has a black background you wish to remove, check the Display 
background value box in the Symbology Mask tab. This will set the background value to have 
no color.

          

men22-7579_fig 01

men22-7579_fig 01

63.	 Click the small x in the upper right corner of the Symbology pane to close it and return to the Catalog pane.
The Syrtis DTM you added to the map covers a large region of Mars. At the current scale, you can only view a small 

portion of it.
64.	 In the Navigate section of the Map tab, click on the small globe icon  to zoom to the full extent of the data. (Note: 

since this is the most expansive dataset in your map, you could accomplish the same thing by right clicking the Syrtis 
DTM layer in the Contents pane and selecting Zoom to Layer)
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Part 7: Working with Geoprocessing Tools

Now that you can view the full extent of the Syrtis DTM, it is clear that this is more data than you need to work with. For 
this activity, you will only be working within the region of the CTX_mosaic layer, which is substantially smaller than the Syrtis 
DTM dataset. Instead of trying to process the entire Syrtis DTM, you can clip this dataset to just the area where you will be 
working.

65.	 In the Geoprocessing section of the Analysis tab, click on the Tools icon to open the Geoprocessing pane.
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The Geoprocessing pane contains many of the data processing and analysis tools that you may need when working in 
ArcGIS Pro. This pane contains three tabs: Favorites, Toolboxes, and Portal. Regardless of which tab you are in, you can 
always quickly search for a tool using the Find Tools search bar at the top of the Geoprocessing pane. The Favorites tab 
contains a list of any tools you have saved as a favorite, and a list of your most recently used tools. The Toolboxes tab contains 
a full list of all the geoprocessing tools that are available, and groups them by which toolbox they are in. In this tab, you can 
manually click through the different toolboxes to access any geoprocessing tool. This is also where you will find any custom 
toolboxes you may have installed (like the USGS Astrogeology Planetary Geologic Mapping Python toolbox). The Portal tab 
lists any geoprocessing tools that are available to you through your organization’s web portal. In most cases, you will only use 
the search bar to find tools, since that is often the quickest and easiest way to access them.

66.	 In the Geoprocessing pane, search for clip. Click on the Clip Raster tool to open it.
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67.	 In the Clip Raster tool, set the following inputs:

Input Raster: Syrtis DTM

Output Extent: CTX_mosaic\Boundary

Use Input Features for Clipping Geometry: Checked

Output Raster Dataset: PlanetaryImageAnalysis_Exercise_2.gdb\Jezero_DTM

Leave all the other automatically populated settings (Rectangle boundaries, and NoData value)

https://astrogeology.usgs.gov/search/map/Docs/PlanetaryDataWorkshop/Presentations2017/Wednesday/Humphreys/PGMM17_PyGM_Toolbox
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68.	 Click Run to clip the Syrtis DTM to your region of interest using the boundary of the CTX_mosaic layer as your 
guide.

When the Clip Raster tool is complete, the new Jezero_DTM layer will be automatically added to your map.
69.	 Click the small x in the upper right corner of the Geoprocessing pane to close it. Then, In the Contents pane, click on 

the small triangle next to the Syrtis DTM layer name to collapse the symbology, and uncheck the box next to Syrtis 
DTM map layer to turn it off.

70.	 In the Contents pane, click on the Jezero_DTM map layer and drag it into the Rasters group. Place the Jezero_DTM 
layer at the top of the Rasters group layers.
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Now that you have the DTM clipped to your region of interest, you do not need to be zoomed out to the current extent.
71.	 In the Contents pane, right click the Jezero_DTM layer and select Zoom to Layer.
When you clipped the Syrtis DTM, the resulting map layer was automatically given the default grayscale symbology and 

0% transparency. You will need to change these to improve the visualization of your data.
72.	 In the Contents pane, select the Jezero_DTM layer and then open the Raster Layer Appearance tab in the menu bar. 

In the Effects section of the Raster Layer Appearance tab, change the layer transparency to 60%.

73.	 In the Contents pane, right click the Jezero_DTM map layer and select Symbology. Change the color scheme to 
Cividis (or the same alternate color scheme as the one you chose earlier) and then close the Symbology pane (click the 
small x in the upper right corner).
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You may notice the color distribution for the Jezero_DTM map layer is different than it was when you were viewing the 
Syrtis DTM map layer. This is because the color ramp is applied using the full range of pixel values in the map layer. The Syrtis 
DTM has a much larger range of elevation values (-6,008 to 4,662), that the color ramp must cover. With the Jezero_DTM 
clipped to your region of interest, you are working with a much smaller range of elevation values (-4,283 to 268), so the color 
ramp is compressed, and more detail is visible.
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74.	 Take a minute to pan around and zoom in and out in this region. Turn the DRA (in the Rendering section of the 
Raster Layer Appearance tab) on and off and see how that changes the symbology of the DTM as you move around. 
When you have finished exploring, make sure DRA is turned back off and zoom back to the full extent of the Jezero_
DTM layer (right click the Jezero_DTM layer in the Contents pane and select Zoom to Layer).

Part 8: Working with Raster Functions

One way to work with raster data in ArcGIS Pro is with raster functions. Raster functions are tools that process your data 
on the fly, and only within the area you are viewing. Unlike geoprocessing tools, raster functions do not create a new data layer. 
Instead, they temporarily apply the process directly to the pixels of the original data layer. This makes raster functions extremely 
useful for quick analyses or experimenting with settings since they process only the data you are viewing and do not take up 
additional computer storage space. Raster function results can also be exported and saved as needed. In addition to single 
step analyses, raster functions can be chained together to create custom functions that can be saved and used again. You will 
experiment with all of these in the upcoming exercises.

75.	 In the Catalog pane, select the Jezero_DTM map layer. Then open the Imagery tab of the menu bar. In the Analysis 
section of the Imagery tab, click on the Raster Functions icon to open the Raster Functions pane.
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The Raster Functions pane has three tabs: Project, System, and Custom. The Project tab will show any custom raster 
functions that you have saved specifically within your current ArcGIS Pro project. The System tab lists all raster functions that 
come with the ArcGIS Pro software. The Custom tab lists all the custom raster functions that you have saved that are not tied to 
a specific ArcGIS Pro project. By default, the System tab will be open when you open the Raster Functions pane.

76.	 At the top of the System tab in the Raster Functions pane, search for Hillshade. Click on the Hillshade icon to open 
the Hillshade raster function.
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77.	 In the Hillshade Raster Function pane, set the Raster to Jezero_DTM. Leave all other default settings. Click Create 
new Layer at the bottom of the Raster Function pane to run your hillshade analysis.

https://pro.arcgis.com/en/pro-app/latest/help/analysis/raster-functions/raster-functions.htm
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When you run the raster function, the layer will be added to your map. The raster function will quickly process only the 
data within the current display extent, and only at the resolution you are currently viewing. If you move around the scene or 
zoom in or out, the raster function will reprocess the data and update the display as you move.

78.	 Take a minute to pan around the region and zoom in and out as you explore. Notice how the Hillshade_Jezero_DTM 
layer updates as you move. When you have finished exploring, return to the full extent of the Jezero_DTM layer 
(Zoom to the Jezero_DTM layer in the Contents pane)

79.	 In the Contents pane, click on the small triangle next to the Hillshade_Jezero_DTM layer to collapse the symbology. 
Then uncheck the box to turn the Hillshade_Jezero_DTM layer off. Click and drag that layer into the Rasters group, 
putting it below the CTX_mosaic layer.
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To complete the landing site assessment in the “Exercise 4” section of this tutorial, one piece of information you will need 
is the slope. You can quickly calculate the slope across your area of interest using raster functions.

80.	 In the Raster Functions pane, search for slope. Then click on the Slope raster function icon to open it.
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81.	 In the Slope Raster Function pane, set the DEM to Jezero_DTM. Leave all other default settings. Click Create New 
Layer at the bottom of the Raster Function pane to run your slope analysis.
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The new Slope_Jezero_DTM layer will be added to your map. To begin, this layer will have the default black and white 
color ramp and 0% transparency, which is not ideal for your visualization purposes.

82.	 In the Contents pane, right click the Map name and select New Group Layer. Rename this layer Raster Functions 
and click and drag the new Slope_Jezero_DTM layer into it. Click on the small triangle next to the Raster Functions 
group to expand it and view the Slope_Jezero_DTM layer in the list.
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83.	 In the Contents pane, select the Slope_Jezero_DTM layer. Then change its transparency to 60% in the Raster Layer 
Appearance tab.

84.	 In the Contents pane, right click the Slope_Jezero_DTM layer and select Symbology to open the Symbology pane. 
In the Symbology pane, change the color scheme to Yellow-Green-Blue (Continuous). (Note: This color scheme is 
very close to the end of the list.)

85.	 In the Contents pane, uncheck the box next to the Jezero_DTM layer to turn it off.
With the Jezero_DTM layer turned off, and the new transparency and symbology for the Slope_Jezero_DTM layer, you 

are now looking at the slopes across the region of interest.
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At first glance, the entire area appears to be one color. However, the slope color scheme covers from 0° to 90°, and despite 
the varied topography in this area, the majority of this area has slopes that are less than 30°, making them appear uniform.

When searching for appropriate landing sites, candidates are limited to slopes that are less than 15°, with slopes of 0° to 5° 
being ideal. With the current color ramp style symbology, it is difficult to discern what areas lie within these constraints.

86.	 In the Symbology pane, change the Primary symbology type to Classify. When you select Classify, you will be 
prompted to compute the histogram for your dataset. Click Yes to compute the histogram.

Once the histogram has been calculated, the Slope_Jezero_DTM layer symbology will change in the Contents and 
Symbology panes.

87.	 In the Symbology pane, change the number of Classes to 3. Then change the Color scheme back to Yellow-Green-
Blue (Continuous) (it reverts to a default color scheme when you change the Primary symbology style).

The Slope_Jezero_DTM layer now shows three slope classes in pale yellow, teal, and dark blue. However, the groupings 
for these classes have been automatically generated and don’t yet match the cutoffs for landing site selection.

88.	 In the Classes tab at the bottom of the Symbology pane, click and hover over the numbers in the Upper value column 
to update them. For the first class, set the upper value to 5. For the second, set the upper value to 15. For the third 
class, set the upper value to 90. Press enter to apply your changes to each value.
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With these changes applied, the Slope_Jezero_DTM layer now shows the areas that are acceptable for landing site selection 
in pale yellow, with areas that have marginally acceptable slopes (5-15°) in teal and unacceptable slopes (>15°) in dark blue.

Summary

In this exercise you learned the basics of working with rasters in ArcGIS Pro, beginning with adding raster data to a map 
project and modifying its display properties and symbology. In situations where you are working with many rasters, it is often 
helpful to put your data into a mosaic dataset. Here you learned how to create, add rasters to, and work with a mosaic dataset 
using a collection of CTX images over Jezero crater and Nili Planum, Mars. You then learned how to use both geoprocessing 
tools and raster functions to process and analyze a set of raster data in this region.
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To Prepare for the Next Exercise

If you wish to start with a fresh GIS project for Exercise 3, click the x in the upper right corner of your ArcGIS Pro window 
to close it. Alternatively, if you prefer to continue working in this GIS project, complete the following steps before moving on 
to Exercise 3: In the Contents pane uncheck the box for the Slope_Jezero_DTM map layer to turn it off. Then click on the 
small triangle next to the Raster Functions group layer to collapse it. Click on the small x’s in the upper right corners of the 
Symbology and Raster Functions panes so all that remains open in that area is the Catalog pane.
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Exercise 3: Working with Vectors
In Exercise 2 you learned how to work with raster data in ArcGIS Pro. Rasters commonly serve as the base imagery and 

additional datasets when performing analyses or creating a geologic map. In this exercise, you will learn how to create and work 
with vector data. Vector data is made of points, lines, and polygons, and is typically used to represent discrete features on the 
surface of a planetary body. Points are often used to indicate the presence of small features like cones, domes, or small craters. 
Lines are commonly used to represent geologic contacts and structures like faults and folds. Polygons are typically used to 
represent geologic units, surficial deposits, and the boundaries of large craters.

If you wish to continue working with the GIS project from Exercise 2: (PlanetaryImageAnalysis_Exercise_2.aprx) skip 
to step 2. If you prefer to start with a fresh GIS project, begin with step 1 below:

1.	 In your Windows File Explorer, navigate to the PlanetaryImageAnalysis\Exercise_3 folder and double click the 
PlanetaryImageAnalysis_Exercise_3 project file (.aprx) to open it in ArcGIS Pro.

The PlanetaryImageAnalysis_Exercise_3 project will open in ArcGIS Pro. Data has already been added to the map, and 
all map layers are listed in the Contents pane.

2.	 Begin by checking your map layers in the Contents pane. All layers should be turned off except the CTX_mosaic and 
Jezero_DTM layers. If you are not currently zoomed to the extent of the Jezero_DTM and CTX_mosaic layers (they 
have the same extent), right click one of those layers in the Contents pane and select Zoom to Layer.
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3.	 In the Contents pane, right click Map and create a New Group Layer. Rename the new group Vector Analysis. All 
the map layers that you create in this exercise will be put into this group layer.
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Part 1: Creating Point Features From an Existing Database

When creating new features in a map, you can draw them manually or import features from an existing database. In this 
section, you will begin by importing crater locations from an existing, previously-published database. The database is already 
included for you in the tutorial materials, but the original database and associated information is available from the USGS 
Astropedia Data Repository.

4.	 In the Catalog pane, expand the Folders → PlanetaryImageAnalysis → Data section. Then right click the 
RobbinsCraterDatabase2014.csv file and select Add to Current Map.
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https://astrogeology.usgs.gov/search/map/Mars/Research/Craters/RobbinsCraterDatabase_20120821
https://astrogeology.usgs.gov/search/map/Mars/Research/Craters/RobbinsCraterDatabase_20120821
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This crater database exists as a .csv file, which is added to your map as a standalone table. When a database is added to the 
map as a table, the features are not yet displayed on the map.
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5.	 Before adding the crater features to your map, it is always good practice to view the table first. In the Contents pane, 
right click the RobbinsCraterDatabase2014.csv table and select Open.

The table will open as a tab at the bottom of your map window. If desired, you can always pull the tab out from the main 
ArcGIS Pro window and view it somewhere else on your screen. (Note: You can also do this with the Contents, Catalog, and 
other panes, and any maps.)
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6.	 Take a minute to scroll through the crater database and explore its contents. As you scroll down, you will notice 
there are several thousand individual craters included in this database. Scroll across to observe the information that is 
included for each.

The Robbins crater database contains several pieces of information for each crater and can be used for a number of 
analyses. For this exercise you will only use the basic latitude, longitude, and diameter information.
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7.	 Click on the small x in the tab at the top of the RobbinsCraterDatabase.csv table to close it.
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8.	 To display the craters from the database, in the Contents pane, right click the RobbinsCraterDatabase2014.csv table 
and select Display XY Data. This will open the Display XY Data window, where you will input the parameters to 
create a new point feature class based on the contents of the database.

9.	 Input the following parameters in the Display XY Data window:

Input Table: RobbinsCraterDatabase2014.csv

Output Feature Class: PlanetaryImageAnalysis_Exercise_3.gdb\Craters_Robbins2014

X Field: LONGITUDE_CIRCLE_IMAGE

Y Field: LATIDUDE_CIRCLE_IMAGE

Z Field: [leave blank]
Note: When you are assigning the X and Y field inputs, you are selecting the database columns that will be used to locate each 
crater on the map.

10.	 In the Display XY Data window, click on the Coordinate System dropdown menu and select the Jezero_DTM layer. 
This will automatically populate the selection for Coordinate System using the projection from the Jezero_DTM layer.
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11.	 In the Display XY Data window, press OK to create the new Craters_Robbins2014 feature class.
The new Craters_Robbins2014 feature class will be added to your map.
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12.	 In the Contents pane, click and drag the Craters_Robbins2014 layer into the Vector Analysis group layer. Then click 
on the triangle to expand the Vector Analysis group layer so the Craters_Robbins2014 map layer is visible.
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13.	 In the Contents pane, check the box to turn on the Syrtis DTM layer. Then right click the Syrtis DTM layer and 
select Zoom to Layer. Take a minute to zoom in and out and pan around to explore the crater database within this area 
(Note: Data points will fall outside the Syrtis DTM region because the crater database covers the entirety of Mars). 
When you have finished, uncheck the box to turn off the Syrtis DTM layer and zoom back to the full extent of the 
CTX_mosaic or Jezero_DTM layer (your region of interest).

Before beginning to work with the Craters_Robbins2014 feature class, it is best to see how it compares to your region of 
interest. There may be more information than is necessary for your analysis.

14.	 In the Contents pane, right click the Craters_Robbins2014 layer and select Attribute Table.
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This will open the attribute table for the Craters_Robbins2014 feature class. At the bottom of the table, you will see 
number of entries that are currently selected out of the total number of entries in the feature class.
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To see how many of 384,278 craters fall within your region of interest, you will use a selection tool.
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15.	 In the Selection section of the Map tab, click on the Select by Location icon.
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The Select by Location tool allows you to select all the features within the Craters_Robbins2014 feature class that are 
located within your area of interest.

16.	 In the Select by Location window, set the following parameters:

Input Features: Craters_Robbins2014

Relationship: Intersect

Selecting Features: CTX_mosaic\Boundary

Search Distance: [leave blank]

Selection type: New selection
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This will select only the crater points which are located within the boundary of the CTX_mosaic map layer.
17.	 Click OK to run the Select by Location tool.
After the Select by Location tool is complete, the crater points located within the boundary of the CTX_mosaic layer will 

be highlighted. Crater points located outside the CTX_mosaic layer boundary will not be highlighted.
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In the Craters_Robbins2014 attribute table, the number of selected features is listed in the bottom left corner.
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This is a global crater database which documents 384,278 individual craters that are greater than or equal to (≥) 3 
kilometers (km) in diameter and covers the entire surface of Mars. The Select by Location results indicate that only 112 of those 
craters lie within your area of interest. Therefore, before beginning to work with this feature class, it will be best to clip it to your 
area of interest. This will reduce the computational and storage needs for your analyses going forward.

18.	 In the Contents pane, right click the Craters_Robbins2014 layer and select Data → Export Features.
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The Export Features tool with either export all the features in a feature class (if no features are selected), or only the 
selected features. This is a quick way to create a new dataset which includes only the craters you selected by location.

19.	 In the Export Features tool window, set the following parameters:

Input Features: Craters_Robbins2014

Output Location: PlanetaryImageAnalysis_Exercise_3.gdb

Output Name: Craters_Robbins2014_Clip
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20.	 Click OK to run the Export Features tool.
When the Export Features tool is complete, the new Craters_Robbins2014_Clip layer will be added to your map.

21.	 In the Selection section of the Map tab, click the Clear icon to clear the selection. Then click the small x in the tab for 
the Craters_Robbins2014 attribute table to close it and return to the full map view.

22.	 In the Contents pane, click and drag the Craters_Robbins2014_Clip layer to the top of the Vector Analysis group. 
Then click the small triangle next to the global Craters_Robbins2014 layer to collapse it and uncheck the box to hide 
this layer. You should now only be viewing the clipped crater points.
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In planetary science, point features typically use circular point symbols, rather than the location markers that are currently 
used for the Craters_Robbins2014_Clip layer.
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23.	 In the Contents pane, click on the Craters_Robbins2014_Clip symbol to open the Format Point Symbol pane.
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24.	 In the Gallery tab of the Format Point Symbol pane, select the Circle 1 symbol. You will see the symbols update on 
your map.
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25.	 In the Format Point Symbol pane, click on the Properties tab.
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26.	 In the Properties tab of the Format Point Symbol pane, set the Size to 4 pt and click Apply. Then click the small x 
in the upper right corner of the Format Point Symbol pane to close it.
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Part 2: Creating Polygons From Points

The database you used to create the Craters_Robbins2014_Clip layer represents each crater using a point feature. 
However, geologic maps often represent the rims of larger craters using polygons to make them easier to identify. In this section, 
you will use the point features from the Craters_Robbins2014_Clip to automatically draw polygons for each crater. There are 
two ways you can complete this task.

Method 1: Proportional Symbology

27.	 In the Contents pane, right click the Craters_Robbins2014_Clip layer and select Symbology to open the Symbology 
pane. In the Symbology pane, change the Primary symbology to Proportional Symbols.
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Proportional symbols allow you to vary the size of the symbol based on one of its attributes. Here, you will vary the size of 
the symbol based on the crater size itself.

28.	 In the Symbology pane, change the Field to DIAM_CIRCLE_IMAGE and set the Unit to kilometers. Change the 
Data represents setting to Radius (1/2 width).

The symbology is now varying the size of the symbol using the DIAM_CIRCLE_IMAGE value. However, in the 
symbology settings, this number represents the radius of the symbol, rather than the diameter, which is the value that is 
represented in the DIAM_CIRCLE_IMAGE attribute.
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29.	 To adjust the Field value to represent the crater radius instead of the diameter, in the Symbology pane, click on the 
Expression  icon next to the Field dropdown menu.
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30.	 In the Expression Builder window, add /2 to the end of the text in the Expression box. This will divide the diameter 
value by 2, which will result in a correct radius.
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31.	 Click OK to apply this change.
The radius of each circle is now representative of the actual crater radius and should roughly line up with the observable 

crater rim. However, the point symbols are currently opaque and contain color, making it difficult to compare them to the base 
imagery and DTM.

32.	 To make your crater outlines easier to see, in the Symbology pane, change the Color (fill color) to No color.
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33.	 Click on the small x in the upper right corner of the Symbology pane to close it.
Your map now shows approximate crater boundaries using just the layer symbology.

men22-7579_fig 01

34.	 Take a moment to explore your map and see how the crater symbology compares to the observable crater rim. When 
you have finished, return to the full extent of the Jezero_DTM/CTX_mosaic/Craters_Robbins2014_Clip layers 
(Contents pane → right click and Zoom to Layer on any of those layers—they all have the same extent).

35.	 In the Contents pane, click and hover over the name for the Craters_Robbins2014_Clip layer to select the layer 
name. Rename this layer Craters_Robbins2014_RimUsingSymbology. This will help you distinguish it from the 
results from the next method, buffering.

men22-7579_fig 01

Method 2: Buffering
The second method to create polygons from points is by buffering. Buffering draws a polygon around a point, keeping a 

consistent distance (the buffer) from that point. The points contained in the crater database can be buffered by their radius to 
create polygons.

You will compare this result to the results of the first method (Craters_Robbins2014_RimUsingSymbology), so you will 
first need to add a new copy of the crater points to the map.
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36.	 In the Catalog pane, right click the Craters_Robbins2014_Clip layer (located in Folders → Exercise_3\
PlanetaryImageAnalysis_Exercise_3.gdb) and select Add to Current Map. (Note: If you don’t see the Craters_
Robbins2014_Clip feature class listed in the geodatabase, right click the PlanetaryImageAnalysis.gdb and select 
Refresh for this new feature class to show up.) After it is added to the map, in the Contents pane, click and drag the 
new Craters_Robbins2014_Clip layer into the Vector Analysis group.
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You should now have both the Craters_Robbins2014_RimUsingSymbology and the new Craters_Robbins2014_Clip 
layers displayed in your map.	
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You will use the crater radius to create the buffer for each point. However, as you observed earlier, the database currently 
only contains the crater diameters. To buffer by the crater radius, you will first need to add a new field to the Craters_
Robbins2014_Clip Attribute Table and calculate the radius for each crater.

37.	 In the Contents pane, right click the Craters_Robbins2014_Clip layer and select Attribute Table.

38.	 In the Attribute Table, click on the Add Field  button.
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A new table will open with all the Fields that are included in the Craters_Robbins2014_Clip Attribute Table.
39.	 At the bottom of the Fields: Craters_Robbins2014_Clip table, enter the following:

Field Name: Radius_Meters (field names may not have spaces)

Alias: Radius (meters) (this is the display name, and may have spaces)

Data Type: Double

Number Format: Numeric (leave all defaults in the Number Format window and click OK)
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40.	 In the Changes section of the Fields tab, click the Save icon to save this new field.
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41.	 Click the small x in the Fields: Craters_Robbins2014_Clip table tab to close the field editor and return to the 
Attribute Table.
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42.	 In the Attribute Table, scroll all the way to the right to view the new Radius (meters) field.
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The Radius (meters) field was just added to the Attribute Table and does not yet contain any values. Before buffering, 
you must calculate the radius for each crater in the table.

43.	 In the Attribute Table, right click the top of the Radius (meters) field and select Calculate Field.
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This will open the Calculate Field tool. The Calculate Field tool can be used to apply a calculation or constant numeric 
value or text string to all items or selected items in a feature class. If no items are selected in the Attribute Table, the tool will 
be applied to all items. If specific items are selected in the Attribute Table, the tool will only be applied to the selected items. 
You need to calculate the radius for every point in the feature class. Therefore, you did not need to select specific items in the 
Attribute Table.

44.	 In the Calculate Field tool, leave the default values for the Input Table, Field Name, and Expression Type. Under 
Expression, double click on DIAM_CIRCLE_IMAGE. You will see it automatically appear in the Radius = text box 
below. Then add /2 to the end of the text string in the Radius = box.
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This calculation will take the value that is contained in the DIAM_CIRCLE_IMAGE field and divide it by 2 to calculate 
the Radius for each crater. However, the original database records the crater diameters in kilometers. To accurately display using 
a buffer, the radius needs to be calculated in meters.

45.	 Modify the text in the Radius = box to read (!DIAM_CIRCLE_IMAGE!/2)*1000 This will multiply the radius by 
1000 to convert it from kilometers to meters.
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46.	 Click OK to run the calculation and return to the Attribute Table. Once the calculation is complete, values will be 
visible in the Radius field.
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47.	 Click on the small x in the Attribute Table tab to close it and return to the map.

48.	 In the Geoprocessing section of the Analysis tab, click on the Tools icon to open the Geoprocessing pane.

49.	 In the Geoprocessing pane, search for Buffer. Click on the Buffer tool to open it.
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50.	 In the Buffer tool, set the following parameters:

Input Features: Craters_Robbins2014_Clip

Output Feature Class: PlanetaryImageAnalysis_Exercise_3.gdb\Craters_Robbins2014_Buffer

Distance: Field

Method: Geodesic (shape preserving)

Dissolve Type: No Dissolve
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51.	 In the blank dropdown menu below Distance [value or field], select the new Radius (meters) field.
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52.	 Click Run to create the new Craters_Robbins2014_Buffer feature class.
When the Buffer tool is complete, the new Craters_Robbins2014_Buffer feature class will be added to the map.
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53.	 Click the small x in the upper right corner of the Buffer tool to exit the Geoprocessing pane.
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54.	 In the Contents pane, click on the Craters_Robbins2014_Buffer layer and drag it into the Vector Analysis group. 
Then right click the Craters_Robbins2014_Clip layer and select Remove to remove it from the map.
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Note: Removing a layer from your map does not delete it. It is still available in the Catalog pane.

The map now contains layers which represent approximate crater diameters through two different methods (proportional 
symbology and buffering).
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55.	 Take a minute to zoom and pan around the map and explore these two layers. Compare the approximate crater 
boundaries with the observable crater rims using the CTX base image (CTX_mosaic) and the DTM (Jezero_DTM). 
You may want to turn DRA on for the DTM layer (select the Jezero_DTM layer in the Contents pane, and turn DRA 
on in the Raster Layer Appearance tab) to make subtle variations in the topography easier to see as you zoom in. 
When you have finished, zoom back to the full extent of the CTX_mosaic or Jezero_DTM layer (they have the same 
extent), and if you turned on DRA for the Jezero_DTM layer, make sure it is turned back off.

In your exploration, you should see that the approximate crater boundaries do not line up exactly with the observable crater rims:
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This is because both methods—proportional symbology and buffering—only provide an approximation for these features. 
Depending on your needs, the approximate methods may be enough for your analysis. However, crater rims are not always 
perfectly circular. These approximations also rely on the location of a point symbol that may or may not be in the exact center of 
the crater, which can result in a crater rim that may be the correct size and shape but is offset. Because of these challenges, crater 
rims are more accurately represented by manually drawn features.

It is common for GIS projects to contain many layers, which can make it difficult to keep track of your datasets and 
features. Grouping and collapsing map layers within the Contents pane is not necessary. However, it can help you and any 
collaborators keep better track of your map layers and be able to view all the most important layers and symbologies at once. 
The crater layers you created in this exercise will not be used in the upcoming activities. To keep them available, but without 
cluttering up the Contents pane, you can group them and quickly hide their details.

56.	 In the Contents pane, select the Craters_Robbins2014_Buffer, Craters_Robbins2014_RimUsingSymbology, and 
Craters_Robbins2014 layers (control+click to select multiple layers). Then right click one of the selected layers and 
select Group. This will create a new subgroup within the Vector Analysis group that contains the three selected layers.
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57.	 In the Contents pane, click and hover over the New Group Layer to activate and edit the group layer name. Rename 
this group layer Craters from Points. Press enter to apply the name change.

men22-7579_fig 01

By grouping these layers, you can now quickly turn all of them on or off with one click.
58.	 In the Contents pane, uncheck the box next to the Craters from Points group to turn off all layers contained within 

that group. Then click on the small triangle next to the Craters from Points group to collapse it.
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Part 3: Drawing Map Features (Points, Lines, and Polygons)

Features in a map are represented using a combination of points, lines, and polygons. These features are drawn manually, 
and like the crater data you worked with earlier, they are stored in a feature class within your project geodatabase. Each feature 
class may only contain one type of feature (point, line, or polygon). However, different kinds of features may be contained 
within a feature class as long as the feature type is consistent. For example, a linear feature class may be used to identify 
anything that can be marked with a line. In planetary geologic mapping, it is typical to group mapping features into the 
following feature classes: geologic contacts (lines), geologic units (polygons), location features (points; small craters, cones, and 
other small features of note), surface features (polygons; coatings of dust or other surface textures), and linear features (lines; 
faults, folds, graben, ridges, channels, and scarps). To become familiar with creating and editing features, you will use a linear 
feature class to place geologic contacts within your area of interest.

When creating a geologic map, all point, line, and polygon feature classes are grouped into a feature dataset. A feature 
dataset is a collection of related feature classes that all use the same coordinate system. Although it is not a requirement to group 
feature classes into feature datasets, this is a necessary step to enable certain functions like checking topologies—a critical step 
in map creation.

The Jezero_Mapping_Practice feature dataset has already been created and is listed under the 
PlanetaryImageAnalysis_Exercise_3 geodatabase.
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59.	 In the Catalog pane, click on the small triangle next to the Jezero_Mapping_Practice feature dataset to expand it and 
view its contents
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The Jezero_Mapping_Practice feature dataset currently only contains the Map Boundary feature class. All feature 
classes that you create for mapping will be added to this feature dataset.

https://pro.arcgis.com/en/pro-app/latest/help/data/geodatabases/overview/feature-class-basics.htm
https://pro.arcgis.com/en/pro-app/latest/help/data/geodatabases/overview/what-is-a-geodatabase-.htm
https://pro.arcgis.com/en/pro-app/latest/help/data/feature-datasets/feature-datasets-in-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/latest/help/data/feature-datasets/feature-datasets-in-arcgis-pro.htm
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60.	 In the Catalog pane, right click the Jezero_Mapping_Practice feature dataset in the PlanetaryImageAnalysis_
Exercise_3.gdb (Folders → PlanetaryImageAnalysis\Exercise_3) and select New → Feature Class.
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61.	 In the Create Feature Class pane set the following parameters:

Name: Geo_Contacts

Alias: Geologic Contacts

Feature Class Type: Line

Geometric Properties: uncheck both boxes (M and Z values are not needed for geologic contacts)
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Depending on what you need, you may click the Next button to move through the remaining steps in the Create Feature 
Class tool. In the remaining steps you can change the fields of the attribute table, the spatial reference (coordinate system), 
tolerance, resolution, and storage options. However, for the Geologic Contacts feature class you are creating today, the default 
settings are appropriate.

62.	 In the Create Feature Class tool, click Finish to create the Geologic Contacts feature class. Then, click on the small 
x in the upper right corner of the Create Feature Class tool to close it and return to the Catalog pane.

The Geo_Contacts feature class has been added to the Jezero_Mapping_Practice feature dataset in the 
PlanetaryImageAnalysis_Exercise_3 geodatabase and is now visible in the Catalog pane.
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63.	 In the Catalog pane, right click the new Geo_Contacts feature class (Folders → PlanetaryImageAnalysis\
Exercise_3\PlanetaryImageAnalysis_Exercise_3.gdb\Jezero_Mapping_Practice) and select Add to Current Map.

The Geo_Contacts feature class will be added to the map as a new layer. When you created the feature class, you set the 
Alias (display name) to Geologic Contacts, which is how the feature class will be listed in the Contents pane. Whenever you 
update the name of a map layer in the Contents pane, you are updating its Alias.
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64.	 In the Contents pane, click and drag the Geologic Contacts layer into the Vector Analysis group.
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The Geologic Contacts feature class has been created, but it does not yet contain any features.
65.	 In the Navigate section of the Map tab, click on the Go To XY icon to enter a location of interest.
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A small window will appear at the bottom of the map with input boxes for the latitude and longitude.
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66.	 In the Go To XY window, input the following coordinates:

Long: 77.397

Lat: 18.520

67.	 Leave the third box set to dd (decimal degrees) and click the Pan to Location  icon to center the map on the specified 
coordinates.
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The map will re-center on the specified coordinates, but it will not zoom in or out.
68.	 To zoom in on the mapping area, locate the scale window in the bottom left corner of the map.
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69.	 Click on the scale window to activate the text and enter 1:75000. Press enter to set the scale.
The map will zoom in to the coordinates on which it was centered (77.397°E., 18.520°N.), to a scale of 1:75,000. 

Alternatively, you could have set the scale first, and use the Go To XY tool to pan to the location after zooming in.
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70.	 The Go To XY tool does not need to remain open while you are mapping. In the Navigate section of the Map tab, 
click on the Go to XY icon again to turn this tool off.

You will be creating a 1:75,000 scale map of this northwest region of Jezero crater. When mapping, it is often helpful to set 
the reference scale of your map. All features (for example, symbols and annotations) are drawn according to the reference scale, 
so this allows you to see how they will appear in your final map product.

71.	 First, check the scale window in the bottom left corner of the map and confirm that you are viewing your map at 
1:75,000. Then, in the Contents pane, right click the Map title and select Set Reference Scale.
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The reference scale will be set to the current map view, which is 1:75,000 and your desired map scale. All map features 
will now be drawn as they will appear at this final printed scale, even as you zoom in and out.

72.	 In the Catalog pane, locate the Map_Boundary feature class which is contained in the Jezero_Mapping_Practice 
feature dataset in the PlanetaryImageAnalysis_Exercise_3 geodatabase (Folders → PlanetaryImageAnalysis\
Exercise_3). Right click on the Map_Boundary feature class and select Add to Current Map.
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The Map_Boundary feature class will be added to the map as a new layer.
73.	 In the Contents pane, click on the symbol listed under the Map_Boundary layer to open the Format Polygon 

Symbol pane.

men22-7579_fig 01



78    User’s Guide to Planetary Image Analysis and Geologic Mapping in ArcGIS Pro

74.	 In the Format Polygon Symbol pane, change the Color to No Color, and the Outline color to Black. Then press 
Apply to update the Map_Boundary symbol.
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75.	 Click the small x in the upper right corner of the Format Polygon Symbol pane to close it and return to the Catalog pane.
The area within the Map_Boundary polygon contains several different geologic units. If desired, you can view the USGS 

map of Jezero crater and Nili Planum by Sun and Stack (2020) and experiment with their interactive map to explore the geology 
within this region. Other planetary and interactive maps and resources can be found on the USGS Planetary Geologic Mapping 
Program website. For this exercise, you will create a simplified 1:75,000 scale map with only three units: the crater floor, 
depositional fan, and surrounding plains.

The current map display has both the CTX basemap (CTX_mosaic) and the DTM (Jezero_DTM) turned on. When 
mapping, you may want to view the DTM occasionally, but map features should be drawn with only the CTX basemap (CTX_
mosaic) turned on. Additional datasets like the DTM are supplemental.

76.	 In the Contents pane, uncheck the box for the Jezero_DTM layer to turn it off.
As you draw your map features, you may turn the Jezero_DTM layer on and off as needed by checking or unchecking its 

box in the Contents pane. It may also be helpful to have DRA turned on (located in the Raster Layer Appearance tab) for the 
DTM to help distinguish smaller terrain details.

You will be creating a 1:75,000 scale map of this area. Standard planetary geologic mapping protocols call for map 
features to be drawn while viewing the area at ¼ of the map scale (as noted on page 14 of the 2022 Planetary Geologic Mapping 
Protocol). For a 1:75,000 scale map that means you should draw all features while viewing the area at 1:18,750 scale. This 
results in map features that contain an appropriate level of detail for the scale at which they are meant to be viewed. Although 
you may be able to view additional details at higher resolutions, drawing map features while zoomed in beyond this limit results 
in too much detail for the resulting map scale.

77.	 In the bottom left corner of the map window, click on the small triangle in the scale box to open it.
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https://pubs.er.usgs.gov/publication/sim3464
https://doi.org/10.5066/P9CZYIO7
https://www.usgs.gov/special-topics/planetary-geologic-mapping
https://www.usgs.gov/special-topics/planetary-geologic-mapping
https://pubs.usgs.gov/tm/11/b13/tm11b13.pdf
https://pubs.usgs.gov/tm/11/b13/tm11b13.pdf
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78.	 Select Customize at the bottom of the scale menu.
This will open the Scale Properties tool where you can customize the options that will be displayed in the pop out scale 

window. When mapping, you will often switch between the printed map scale (1:75,000) and the digital map scale. The digital 
map scale is the scale at which features will be drawn. In this case, the digital map scale is 1:18,750. Therefore, it is helpful to 
add both of these to the quick list of scale options.

79.	 You are currently viewing the map at the printed map scale of 1:75,000. In the Scale Properties window, click Add 
Current to add the printed map scale (1:75,000) to the list.

The printed map scale of 1:75,000 has been added to the list of scale options. 
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80.	 In the Scale Properties window, there are two blank boxes at the top. Enter 1:18750 in the left (Scale) box. Then press 
Add to add this scale to the list of options.
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1:75,000 and 1:18,750 have been added to the scale options and both are now visible in the Scale Properties list.
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81.	 Click OK to exit the Scale Properties tool. Then open the scale pop out menu in the bottom left corner of the map to 
observe the updated options. You will see the 1:18,750 and 1:75,000 scales now listed.
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While mapping, you can quickly switch between the printed (1:75,000) and digital (1:18,750) map scales by clicking 
on them in the scale pop out menu. Using the 1:18,750 option when viewing the map will also prevent you from accidentally 
zooming in too far and drawing map features at an inappropriate resolution.

You will begin mapping by adding linear features to the Geologic Contacts feature class. In previous steps, you added this 
feature class to the map, but it does not yet contain any objects.

82.	 In the Contents pane, select the Geologic Contacts layer. Then, in the Features section of the Edit tab, click on the 
Create icon.
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This will open the Create Features pane. The Templates tab will list all the feature classes that are currently available for 
editing.
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83.	 In the Create Features pane, click on the Geologic Contacts feature class to begin editing it.

Note to ArcMap users: In ArcGIS Pro, you no longer need to start (or stop) a separate editing session. Instead, by 
accessing the tools in the Edit tab, you are automatically entering the editing mode. You do, however, still need to save 
the edits you make within this tab.

With the Geologic Contacts feature class selected, several drawing options will appear in the Create Features pane.
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In geologic mapping, the most frequently used options for drawing linear features are:
Line  (default selection): Click to manually place individual points (vertices) along the line.

Stream : Automatically places vertices along a line by tracking the position of your pointer. This setting is ideal for 
those working with a digitizing tablet or touchscreen.

During this exercise, you will experiment with both the Line and Stream options.
84.	 In the Navigate section of the Map tab, click on the Go To XY tool to open it. Enter the coordinates 77.309 (Long.) 

and 18.408 (Lat.) and click the Pan to Location  icon to center the map on this location. Then use the scale pop out 
menu to select and zoom to the 1:18,750 scale.

This location is where the geologic contact between the crater rim/plains materials and the crater floor materials (dashed 
line below) intersects the Map_Boundary. You may need to zoom in and out to orient yourself within the map area and get 
context. The coordinates you entered in the Go To XY tool will remain, and you can return to this location by clicking the Pan 
to Location  icon again and selecting 1:18,750 in the scale pop out menu.
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85.	 To begin drawing, in the Create Features pane, confirm the Line  option is selected under Geologic Contacts.

86.	 In the map window, click to place the southernmost vertex marking the boundary between the crater rim/plains 
materials and the crater floor materials. Once you click, a dashed line will appear between the placed vertex and your 
pointer. This shows you what the line will look like as you click to place additional vertices.
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87.	 Click to place 3 or 4 more vertices along the boundary between the crater rim/plains materials and the crater floor 
materials (do not go beyond the current display of the map). Then double click to place one final vertex and finish 
drawing this line.
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When you double click to finish drawing a feature, it will be highlighted in bright blue (see above).
88.	 In the Selection section of the Map tab, click Clear to deselect all features.
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89.	 Use the scroll wheel of your mouse to zoom in to the first (southernmost) vertex you placed.

Tip: When in editing mode, you can not click and drag the map to pan. Clicking on the map will begin to place a new 
feature. Instead, click and drag using the middle button or scroll wheel of your mouse, or press and hold the “C” key 
while left clicking and dragging. If you accidentally click in the map and begin creating a new feature, you can cancel 
that drawing action by right clicking in the map and selecting Cancel.
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When drawing geologic contacts, it is imperative that there are no gaps like the one shown above. In subsequent mapping 
stages, you will use the geologic contacts to create polygon features representing each geologic unit. If there are gaps between 
the geologic contacts, the tool will view those as one contiguous unit and the resulting polygons will not be correct. To prevent 
this issue, it is best to turn on Snapping while drawing your geologic contacts. Snapping will automatically place vertices on 
top of another feature if it is close by.

90.	 In the Snapping section of the Edit tab, click on the Snapping icon to turn Snapping on.
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When Snapping is on, this icon will be highlighted in blue. An additional small Snapping icon is also available in the bottom 
left corner of the map window, next to the scale pop out menu. You can also quickly turn Snapping on and off using this icon.
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91.	 With Snapping on, hover over and around the Map_Boundary and note how the vertex is placed.
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With Snapping on, the vertex will be pulled to the nearby feature—in this case, the Map_Boundary—as long as it is 
within a specified distance. As you map, there are times where you may or may not want to have Snapping on. You can quickly 
turn Snapping on and off using the small Snapping icon in the lower left corner of the map.

92.	 In the Go To XY tool, click on the Pan to Location  icon again and select 1:18,750 in the scale pop out menu to return 
to the appropriate mapping scale.

Since the first line was drawn without Snapping on, you will need to edit the first vertex so it intersects the Map_Boundary.
93.	 In the Selection section of the Edit tab, click on the Select icon.
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The Select icon will be highlighted in blue when it is turned on.
94.	 In the map, click on the line you drew earlier to select it.
When you click on the Geologic Contact, you will notice the Map_Boundary is highlighted in blue, instead of the 

Geologic Contact. This is because both feature classes are available and selectable in the map. You can click on the select 
feature  icon in the map to change the selection. However, it is easiest to change the Map_Boundary layer so it is not 
selectable. This will prevent this issue going forward.

95.	 In the Contents pane, right click the Geologic Contacts layer and select Selection → Make this the only selectable layer.
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96.	 In the map, click on the Geologic Contact feature you drew earlier to select it.
Now that the Geologic Contacts layer is the only selectable layer, the feature will be selected and highlighted in blue.

97.	 In the map, right click on the selected feature and select Edit Vertices.
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98.	 Zoom in to the southernmost vertex. Then click and drag the southernmost vertex so it snaps to the Map_Boundary.
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When editing vertices, the dashed line shows the updated feature. The initial blue line also remains. This allows you to see 
what the updated feature will look like compared to how it was before editing.

99.	 With the southernmost vertex now snapped to the Map_Boundary, use the scale pop out menu to return to 1:18,750 
scale.

100.	 Along the right side of the map is the Edit Vertices toolbar. Click on the Continue Feature  icon to continue drawing 
this feature.
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The Continue Feature editing mode will continue drawing the feature from the red endpoint vertex.
101.	 Use the Continue Feature editing mode to draw and extend the Geologic Contact between the crater rim/plains 

materials and the crater floor. Double click to place the final vertex on the northern Map_Boundary. To pan as you draw, 
click and drag using the middle button or scroll wheel of your mouse, or press and hold the “C” key while left clicking 
and dragging. If you accidentally click in the map and begin creating a new feature, you can cancel that drawing action by 
right clicking in the map and selecting Cancel. Remember to not zoom in beyond the 1:18,750 scale while drawing.
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When editing and creating features, you must save your work. This is separate from saving your overall map project.
102.	 In the Manage Edits section of the Edit tab, click Save. Click Yes to save all edits.
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If you try to save your map project without saving your edits, you will be automatically prompted to save your edits before 
saving the overall map project.

Now that you have finished editing the geologic contact between the crater rim/plains materials and the crater floor, you can 
return to the Create Features pane.

103.	 To return to the Create Features pane, click on the Create Features tab at the bottom of the Edit Vertices (Active 
Tool) pane.
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104.	 In the Create Features pane, select the Geologic Contacts feature class to continue adding features to it. Then select 
the Stream option.
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To draw the second geologic contact you will use and experiment with the Stream mode. The streaming mode is ideal for 
those who are working with a digitizing tablet or a touchscreen but can be used with a mouse as well. (Alternate option: If you 
find the streaming mode does not work well with your computer setup, right click in the map area while still drawing the feature 
and select Cancel. Then change to the Line mode in the Create Features pane and draw the geologic contact as you did in the 
previous steps.

105.	 For the second geologic contact, use the Stream method to mark the approximate boundary of the fan-shaped feature 
located on the crater floor (dashed line in image below):

A.	 Use the scale pop out menu to zoom in to the appropriate digital mapping scale (1:18,750)

B.	 Pan around the area by clicking with the middle mouse button or holding the C key while left clicking and 
dragging the map.

C.	 When drawing features in Stream mode, click once to begin drawing the feature. Vertices will be automatically 
created following the path of the cursor until you double click to finish drawing.

D.	 To pause the drawing of vertices (for example, if you need to move your cursor off the path of the boundary or 
pan the map to another area), press and hold the C key. The vertices will begin drawing again as soon as you let 
go of the C key.

E.	 As you practiced earlier, the beginning and ending vertices should be snapped to their abutting feature—in this 
case, this is the geologic contact you drew in the previous steps.
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Now that the fan boundary is complete, you have finished drawing the Geologic Contacts for your map. After drawing 
features, it is typical to need to clean up vertices and make edits to those features.

106.	 Zoom in to the area of your map where the geologic contacts intersect. This should be on the east side of the fan.
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When drawing the fan boundary, you snapped the beginning and ending vertices to the existing geologic contact, so there 
are no gaps between the features. However, snapping features during streaming mode can result in additional, unnecessary, and 
often inaccurate vertices which need to be edited.

107.	 In the Selection section of the Edit tab, click on the Select icon. Then click on the fan boundary to select it.
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108.	 Right click the selected feature and choose Edit Vertices.

109.	 Click on the Delete  icon in the Edit Vertices toolbar that is displayed along the right edge of the map.
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110.	 Zoom in to each end of the fan boundary feature and check the vertices. Snapping during Stream mode will often 
result in excess vertices that need to be removed like the ones shown here:
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111.	 With the Delete tool selected, click on each erroneous vertex to delete it. Like before, the dashed line will update to 
show the current feature, while the highlighted blue line will remain for comparison.
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112.	 Check the other end of the fan boundary and remove any unnecessary vertices.
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113.	 Pan through the rest of the fan boundary feature and check for any other vertices that need to be deleted or moved. Use 
the middle button of your mouse or press and hold the C key while clicking and dragging the map to pan.

A.	 To move a vertex (but not delete it), use the Select  tool at the top of the Edit Vertices toolbar. Then click on the 
vertex you wish to move and drag it to the desired location.
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114.	 When you have finished editing the vertices, click on the Finish  icon in the Edit Vertices toolbar.
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115.	 In the Manage Edits section of the Edit tab, click Save to save the edits you made to the Geologic Contacts feature 
class. Click Yes to save all edits.

116.	 Click the small x in the upper right corner of the Edit Vertices pane to close it. Click the small x in the upper right 
corner of the Create Features pane to close that as well.

117.	 In the Selection section of the Edit tab, click Clear to de-select all features.

118.	 In the Contents pane, right click the Map_Boundary layer and select Zoom to Layer to observe the full extent of the 
map area.
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When the Geologic Contacts features were created, they were assigned a default symbology. When mapping, you can 
update the symbology manually through the Symbology pane, but it is typical to apply standard symbologies to your features 
using a pre-existing set of symbols. These are contained in a layer file (.lyr).

119.	 In the Contents pane, select the Geologic Contacts layer. Then in the Geoprocessing section of the Analysis tab, 
click on the Tools icon to open the Geoprocessing pane. In the Geoprocessing pane, search for layer symbology. 
Then click on the Apply Symbology From Layer tool to open it.
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120.	 In the Apply Symbology From Layer tool, set the Input Layer to Geologic Contacts. Then click on the Open  icon 
for the Symbology Layer and navigate to the PlanetaryImageAnalysis\Exercise_3\FeatureLayerSymbology folder. 
Select the GeoContacts_2018.lyr file and click OK.
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121.	 In the Apply Symbology From Layer tool, leave all other defaults and click Run.
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122.	 Click on the small x in the upper right corner of the Apply Symbology From Layer tool to close it and return to the 
Catalog pane.

In the Contents pane, you will see the Geologic Contacts layer symbology has been updated to reflect the new schema.
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The Geologic Contacts feature class symbology has been updated, but the boundaries you created do not yet have types 
assigned to them.

123.	 In the Contents pane, right click the Geologic Contacts layer and select Attribute Table.

124.	 In the Geologic Contacts Attribute Table, click on the Add Field icon to open the field editor.
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125.	 In the Fields: Geologic Contacts tab create a new field with the following parameters:

Field Name: TYPE (The field name must match what is listed in the Contents pane at the top of the layer symbology)

Alias: TYPE

Data Type: Text

Length: 255
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126.	 Press enter to finalize your entry. Then, in the Changes section of the Fields tab, click Save to save your edits.

127.	 Click on the small x in the Fields: Geologic Contacts tab to close the field editor and return to the Geologic Contacts 
Attribute Table.

When a new field has been added to the Geologic Contacts Attribute Table. In the new TYPE field, all values are set to 
<Null> and contain no data. This new TYPE field is where you will assign boundary types. The boundary types that are entered 
should match those that are displayed in the Geologic Contacts layer symbology.

128.	 In the Geologic Contacts Attribute Table, click on the box to the left of the first row to highlight that object. The 
feature will also be highlighted in the map.
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129.	 For the boundary between the crater rim/plains materials and the crater floor, click in the TYPE field and enter 
approximate. Press enter to finalize this entry. For the fan boundary, set the TYPE to certain and press enter to 
finalize this entry.

130.	 In the Geologic Contacts Attribute Table toolbar, click on the Clear icon to clear the selection. Then, in the Manage 
Edits section of the Edit tab, click on the Save icon to save the updates to the Attribute Table. Click Yes to save all 
edits. Once your edits have been saved, click on the small x in the Geologic Contacts Attribute Table tab to close it 
and return to the full map view.
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When you return to the map, you will see the updated Geologic Contacts, which now reflect the boundary types that were 
assigned.

You have finished drawing the Geologic Contacts for your simplified map of northwest Jezero crater. In addition to 
drawing linear features, you can also create point- or polygon-based features. The process is similar to the one you just followed 
to create the Geologic Contacts linear features. Since feature classes can only contain one type of shape (points, lines, or 
polygons) point and polygon features must be contained in their own feature classes.

Part 4: Creating Polygons From Linear Features

In the previous section, you created the Geologic Contacts for a simplified map of northwest Jezero crater, Mars. The 
Geologic Contacts feature class identifies the boundaries for three units: The crater rim/plains materials, crater floor, and 
depositional fan. These Geologic Contacts can now be used to create the polygons which will represent each geologic unit.

Before using the Geologic Contacts feature class to create polygons, there are few steps that must be taken to prepare the 
data. There are two locations in your map (black arrows) where features intersect:
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The Features to Polygon geoprocessing tool will use the Geologic Contacts and Map_Boundary feature classes to create 
polygons. However, to properly build the polygons, the tool requires that all linear input features (the Geologic Contacts) must 
be split at any point that they intersect so each polygon boundary is distinct. If the lines are not split, the tool can not properly 
identify the polygon boundaries and they will be combined.

131.	 In the Tools section of the Edit tab, click on the Split icon.
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132.	 In the map, click on the unit boundary between the crater rim/plains materials, and the crater floor to select it. Then 
zoom to the region where this boundary intersects the boundary of the fan unit (blue box in the image below).
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133.	 In the map, use your cursor to hover over one of the points where these two boundaries intersect. With Snapping 
on, the cursor will snap to the features. When you are at the location where the two features intersect, the cursor will 
display Geologic Contacts: Endpoint.
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134.	 In the map, click once on the point of intersection to split the line at that location. You should see one portion of the 
split line flash to indicate it has been separated into a new, distinct line.

135.	 In the map, move along the selected boundary and repeat the previous step to split it at the second point where it 
intersects with the fan boundary.

136.	 In the Selection section of the Edit tab, click on the Clear icon to clear the selection. Then click on the Select icon to 
enable it.

137.	 In the map, click on the different sections of the boundary line you just split to confirm that they have been separated. 
There should now be three distinct sections:
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138.	 In the Selection section of the Edit tab, click Clear to clear the current feature selection.

139.	 In the Manage Edits section of the Edit tab, click on the Save icon to save the changes to this feature class. Click Yes 
to save all edits.

140.	 Click on the small x in the upper right corner of the Modify Features pane to close it.

141.	 In the Contents pane, right click the Map_Boundary layer and select Zoom to Layer to return to the full extent of 
your map.

With the Geologic Contacts split, you can now build polygons for the geologic units. However, before building the 
geologic unit polygons, it is best to complete a topology check. A topology check makes sure there are no fundamental errors in 
the geologic contacts that could cause problems when you create the unit polygons.

142.	 In the Catalog pane, right click the Jezero_Mapping_Practice feature dataset in the PlanetaryImageAnalysis_
Exercise_3.gdb (Folders → PlanetaryImageAnalysis\Exercise_3) and select New → Topology
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143.	 In the first step of the Create Topology Wizard tool, you will select which feature classes you want to include. All 
feature classes that exist in the feature dataset are listed under Feature Classes. Click Select All to select all feature classes 
that are available, and then click Next at the bottom of the Create Topology Wizard tool to move to the next step.
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Here, you will add the rules against which your map features will be checked. There are five fundamental rules for geologic 
contacts. A geologic contact must not:

1.	 Overlap with other lines,

2.	 Overlap with itself,

3.	 Intersect with other lines,

4.	 Intersect with itself,

5.	 Dead end (“dangle”).

144.	 In the Add Rules tab of the Create Topology Wizard tool, click on the table to add a new rule.
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145.	 In the Create Topology Wizard tool, click on the dropdown menu under Feature Class 1 and select Geo_Contacts.
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146.	 In the Create Topology Wizard tool, click on the empty box under Rule to open a dropdown menu. Then select Must 
Not Overlap (Line).
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147.	 Repeat the previous steps to add four more rules to the table, checking the Geo_Contacts Feature Class: Must Not 
Intersect (Line), Must Not Have Dangles (Line), Must Not Self Overlap (Line), and Must Not Self Intersect (Line).
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148.	 Click Finish to run the topology check.

149.	 After the topology check is complete, the topology file will be added to the Jezero_Mapping_Practice feature dataset. 
In the Catalog pane, click the small triangle next to the Jezero_Mapping_Practice feature dataset to re-expand it (it 
automatically collapsed when the topology file was added) and view its contents.
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150.	 Before viewing the topology results, they should be validated. In the Catalog pane, right click the Jezero_Mapping_
Practice_Topology item and select Validate.
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151.	 Once the validation is complete, in the Catalog pane, right click the Jezero_Mapping_Practice_Topology item and 
select Add to Current Map.
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The topology results will be added to your map and will be listed in the Contents pane as a new map layer.
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The topology results enable you to see if there are any areas of your map that violate the 5 rules you entered in the previous 
steps. If you have followed the instructions closely, you should see two red point errors in your map: one at the top, and one at 
the bottom (see the image above). Before moving on to create the geologic unit polygons, all topology errors must be reviewed 
and fixed as necessary.

152.	 In the Manage Edits section of the Edit tab, click on the Error Inspector icon.
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The Error Inspector will open in the bottom half of the window. By default, the Jezero_Mapping_Practice_Topology 
layer should be selected as the Source in the upper left corner of the Error Inspector.
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153.	 There are no features currently selected, so initially the Error Inspector table will appear empty. Pan through your 
map and click on the point error located on the southern edge of the map boundary to select it. Once the point error is 
selected, it will appear in the Error Inspector.
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The Error Inspector will list the reason for the error under the Rule column. The rule that is listed here is the rule that is 
violated at this location. According to the topology check, the point at the southern map boundary violates the “Must Not Have 
Dangles” rule. You will use this information check and, if necessary, revise the linework at this location.

154.	 In the Map window, zoom in extremely close (approximately [~] 1:100 scale) to the location of this point error. Once 
you are zoomed in, in the Contents pane, uncheck the box next to the Jezero_Mapping_Practice_Topology layer to 
turn it off. This will allow you to check that the geologic contact and the map boundary connect at this location. Since 
you drew your contacts with snapping on, you should not have a dangle at this location, and the contact should appear 
like the “No Dangle” example shown below:
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Note: If you do have a dangle at this location, use the Edit Vertices tool in the Tools section of the Edit tab to fix it before moving 
on.

If the Geologic Contact feature is touching the Map Boundary at this location, it is drawn correctly and is not an error. 
Instead, this location has been marked as an error because the topology tool was only checking the Geologic Contacts feature 
class and did not take into account the Map Boundary layer. However, the Map Boundary layer will also be used when you 
build the polygons for the geologic units. If you do not have a dangle at this location, this topology error should be marked as an 
exception before you move on to check any others.

155.	 In the Contents pane, check the small box next to the Jezero_Mapping_Practice_Topology layer to turn it back on. 
Then, in the Map window, click on the point error at this location to make sure it is selected. In the Error Inspector 
pane, click on the point error to select it and then click on the Fix tab (located at the top of the Preview window) to 
view the available fixes for this feature.
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156.	 Since this location is not a true dangle, it does not need to be fixed, and instead should be marked as an exception. In 
the Fix tab of the Error Inspector, click on the Mark as Exception button.
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You will see the Error Inspector table update to show this point error is now marked as an exception.
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157.	 In the Map window, pan and zoom to view the point error on the northern edge of the Map Boundary. Then repeat 
the steps to check if this location is a true dangle. After checking the error, remedy any potential dangles (if necessary) 
and mark the error as an exception.
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Note: If there are any other errors highlighted in your topology results, you will need to review and fix them (this is often done 
using the edit vertices tool) before moving on to the next step.

158.	 Once you have finished checking (and fixing, if necessary) all topology errors, in the Manage Edits section of the Edit 
tab, click the Save icon (if possible—if you did not make any changes to your map, this icon may not be active) and click 
Yes to save all edits. Then, in the Selection section of the Edit tab, click the Clear icon to deselect any topology features.

159.	 Click on the small x in the upper right corner of the Error Inspector to close it. Then, in the Contents pane, right 
click the Map Boundary layer and select Zoom To Layer. In the Contents pane, uncheck the box next to the Jezero_
Mapping_Practice_Topology layer to turn it off, then click on the small arrow to collapse it. Drag the Jezero_
Mapping_Practice_Topology layer to the top of the Vector Analysis group.
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Now that you have checked topologies and fixed any errors, you are ready to create the polygons for your geologic units 
using the Geologic Contacts and Map Boundary features.

160.	 In the Geoprocessing section of the Analysis tab, click on the Tools icon to view the Geoprocessing pane. In the 
Geoprocessing pane, search for Feature to Polygon, and click on the Feature to Polygon tool to open it.
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161.	 In the Feature to Polygon tool, set the following parameters:

Input Features: Map_Boundary, Geologic Contacts

Output Feature Class: PlanetaryImageAnalysis_Exercise_3.gdb\Jezero_Mapping_Practice\Geo_Units

Preserve attributes: leave checked

Label Features: <leave blank>
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162.	 Click Run to create the Geo_Units polygon feature class.
When the Feature to Polygon tool is complete, the new Geo_Units feature class will be added to the map as a new layer.

163.	 Click the small x in the upper right corner of the Feature To Polygon tool to close it.

164.	 In the map, click inside each of the different geologic units to explore the new Geo_Units layer. Confirm that there are 
three separate units, and they are the correct size, shape, and location.
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165.	 In the Contents pane, right click on the Geo_Units layer and select Attribute Table to open it.
The Geo_Units Attribute Table contains three polygons.

166.	 In the Attribute Table, click on the gray box to the left of each row to select it. When an object is selected in the 
Attribute Table, it will also be highlighted on the map.
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167.	 After you have explored each polygon, click on the Clear  icon in the Attribute Table toolbar to clear the selection.
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Polygons have been created for the geologic units (Geo_Units), but the Attribute Table does not yet contain a field in 
which you may assign geologic units to them.

168.	 In the Geo_Units Attribute Table, click on the Add Field  icon.
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This will open the Geo_Units Attribute Table Field editor in a new tab.
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169.	 In the Fields: Geo_Units table, enter the following:

Field Name: Unit_Name

Alias: Unit Name

Data Type: Text

Length: 255
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170.	 Press enter to finalize the new field entry. Then, in the Changes section of the Fields tab, click the Save icon to save 
this new field.

171.	 Click on the small x in the Fields: Geo_Units tab to close it and return to the Geo_Units Attribute Table.
The Geo_Units Attribute Table will automatically update to include the new Unit Name field.
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172.	 To assign a Unit Name to each polygon, click and hover over the <Null> Unit Name value for each row to select the 
text. Once the text has been selected, type the new Unit Name and press enter to apply the change. Enter the new unit 
name for each of the three polygons: Crater Rim and Plains, Crater Floor, and Fan
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Now that the polygons have unit names, the symbology can be updated to reflect these units.
173.	 Click on the small x in the Geo_Units Attribute Table tab to close it.

174.	 In the Contents pane, right click the Geo_Units layer and select Symbology.



112    User’s Guide to Planetary Image Analysis and Geologic Mapping in ArcGIS Pro

175.	 In the Symbology pane, change the Primary symbology to Unique Values. Then set Field 1 to Unit Name.
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176.	 In the Classes tab of the Symbology pane, click on the colored symbol box for the Crater Floor unit to open the 
Format Polygon Symbol options. Then click on the Properties tab to switch to the manual symbol options. Set the 
Color to Cattleya Orchid, and the Outline Color to No Color. Then click Apply to update the symbol.
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177.	 Click on the back arrow in the upper left of the Format Polygon Symbol pane to return to the Symbology pane. Then 
repeat the above steps to update the Color and Outline Color for the Crater Rim and Plains (Olivenite Green/No 
Color) and Fan (Cretan Blue/No Color) units.



Exercise 3: Working with Vectors    113

men22-7579_fig 01

Unit colors are meaningful and typically help indicate the rock type and (or) origin of the unit. See the USGS Planetary 
Mapping Guidelines for more information. The colors used in this exercise are adapted from the interactive version of the USGS 
map of Jezero crater and Nili Planum, Mars (Sun and Stack, 2020).

178.	 Click on the small x in the upper right corner of the Symbology pane to close it.
As you edited the Geo_Unit symbols, the map and Contents pane automatically update to reflect these changes.
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Now that you have created the polygons for the geologic units and applied the symbology, you can view this layer on top of 
the base imagery.

179.	 In the Contents pane, select the Geo_Units layer. Then, in the Effects section of the Feature Layer Appearance tab, 
set the transparency to 70%.

180.	 In the Contents pane, click on the Geo_Units layer and drag it into the Vector Analysis group, placing it below the 
Geologic Contacts layer. This will allow the Geologic Contacts to be visible since they will now be drawn on top of 
the Geo_Units layer.

https://www.usgs.gov/special-topics/planetary-geologic-mapping/current-planetary-mapping-guidelines
https://www.usgs.gov/special-topics/planetary-geologic-mapping/current-planetary-mapping-guidelines
https://doi.org/10.5066/P9CZYIO7
https://usgs.maps.arcgis.com/apps/webappviewer/index.html?id=a0ae4b521f7a4a6ca2cf0f0c551d5293
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Summary

Through this exercise you explored the basic process of planetary geologic mapping and learned how to import, create, and 
work with vector data in ArcGIS Pro. You imported a Martian crater database, an existing point-based dataset, and used those 
data to create polygons representing crater rims within your map area through two different methods: symbology, and buffering. 
You also learned how to create and add features to a new feature class by drawing geologic contacts for the three generalized 
geologic units within your map area. You then learned how to complete a topology check before creating geologic unit polygons. 
You also learned how to create polygons from linear features and used the geologic contacts feature class to create polygons for 
each geologic unit. In addition to creating and editing features, you also learned how to edit attribute tables to assign contact 
types and unit names, and how to update symbologies to reflect those new attributes both manually and through the use of 
symbology layer files. These processes represent the basic process for planetary geologic mapping. Several planetary geologic 
mapping tools are available through the Planetary Geologic Mapping Program website, including the Planetary Geologic 
Mapping (PGM) Toolbox. The PGM Toolbox includes several tools which help automate steps in the mapping process and 
help to check your work for errors before proceeding. Additional guidelines for planetary geologic mapping can be found in the 
USGS Astrogeology Planetary Mapping Guidelines.

To Prepare for the Next Exercise

If you wish to start with a fresh GIS project for Exercise 4, click the x in the upper right corner of your ArcGIS Pro window 
to close it. Alternatively, if you prefer to continue working in this GIS project, complete the following steps before moving on 
to Exercise 4: In the Contents pane, click on the small triangle next to the Vector Analysis group to collapse it and uncheck 
the box for the group to turn off all layers within it. You should end with only the base CTX imagery (CTX_mosaic) displayed. 
Then, in the Contents pane, right click the CTX_mosaic layer and select Zoom to Layer to view the full extent of your region 
of interest.

https://www.usgs.gov/special-topics/planetary-geologic-mapping/mapping-and-gis-resources
https://doi.org/10.3133/tm11B13


Exercise 4: Analyzing Data for Threshold Criteria (Landing Site Selection)    115

Exercise 4: Analyzing Data for Threshold Criteria (Landing Site Selection)
In planetary science, GIS is often used to conduct analyses and interpret data to better understand planetary bodies. One 

such analysis is selecting suitable sites for landed missions like NASA’s Mars Science Laboratory (MSL) rover (Curiosity) 
which landed in Gale crater on August 6, 2012, and the Mars 2020 rover (Perseverance) which landed in Jezero crater on 
February 18, 2021. Landing site selection must consider several factors such as the elevation, slope, and rockiness of an area. 
These factors, along with many others, are assessed to identify regions where a spacecraft may land safely. In this exercise, 
you will conduct a simplified landing site assessment in the Jezero crater and Nili Planum region using two different methods: 
geoprocessing tools, and raster functions.

As you learned in Exercise 2, raster functions differ from geoprocessing tools because they apply the function directly 
to the pixels of the input data and show the result as a temporary data layer. This decreases the amount of computer storage 
space that is needed to complete an analysis. Raster functions also only complete the analysis for the pixels you are currently 
viewing (those within the current display extent) and only at the scale which they are being viewed. This makes raster functions 
particularly useful for quick analyses and experimentation. Additionally, raster functions may be strung together to create 
custom raster functions, which can be saved and used later by you and those with whom you share the custom raster function.

Part 1: Analysis with Geoprocessing Tools

If you wish to continue working with the GIS project from Exercise 3 (PlanetaryImageAnalysis_Exercise_3.aprx) skip to 
step 2. If you prefer to start with a fresh GIS project, begin with step 1 below:

1.	 In your Windows File Explorer, navigate to the PlanetaryImageAnalysis\Exercise_4 folder and double click the 
PlanetaryImageAnalysis_Exercise_4 project file (.aprx) to open it in ArcGIS Pro.

The PlanetaryImageAnalysis_Exercise_4 project will open in ArcGIS Pro. Data has already been added to the map, and 
all map layers are listed in the Contents pane.

2.	 Begin by checking your map layers in the Contents pane. All layers should be turned off except the CTX_mosaic 
layer. If you are not currently zoomed to the extent of the CTX_mosaic layer, right click it in the Contents pane and 
select Zoom to Layer.
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https://www.nasa.gov/mission_pages/msl/index.html
https://mars.nasa.gov/mars2020/
https://pro.arcgis.com/en/pro-app/latest/help/analysis/geoprocessing/basics/what-is-geoprocessing-.htm
https://pro.arcgis.com/en/pro-app/latest/help/analysis/raster-functions/raster-functions.htm
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3.	 In the Contents pane, right click Map and select New Group Layer. Then click on this New Group Layer and hover 
to rename it. Rename this group layer GP Tool Process and press enter to finalize the new group layer name.
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All outputs which are created in this section will be placed in this new group layer.
4.	 In the Contents pane, click on the small triangle next to the Raster Functions group to expand it. Then check the box 

for the Slope_Jezero_DTM raster function layer you created in Exercise 2 to turn it back on.

men22-7579_fig 01

Although the Slope_Jezero_DTM layer was created using a raster function, it can still be used as an input layer for a 
geoprocessing tool the same way you would input any other raster layer. Alternatively, this slope analysis layer could have been 
created using the Slope geoprocessing tool. Since you already created it using the raster function, you will use the raster function 
layer as the input for the next step.
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5.	 In the Geoprocessing section of the Analysis tab, click on the Tools icon to open the Geoprocessing pane. Then 
search for the Reclassify tool and click to open it.
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6.	 In the Reclassify tool pane, set the following inputs:

Input raster: Slope_Jezero_DTM

Output raster: PlanetaryImageAnalysis_Exercise_4.gdb\SlopeReclass

Leave all other default values.
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In Exercise 2, you set the Slope_Jezero_DTM layer symbology to classes. Because the classes have already been defined, 
they will automatically be used as the Reclassification boundaries for the Reclassify tool. If needed, you could alter those 
boundaries before running the tool. For this analysis, these boundaries are already set to what you need.

7.	 Click Run to run the Reclassify tool.
The Reclassify tool output (SlopeReclass) will be added to the map as a new layer.
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8.	 In the Contents pane, click on the SlopeReclass layer and drag it into the new GP Tool Process group. Then click on 
the small triangle to expand the GP Tool Process group and view its contents.
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9.	 Take a moment to explore the output from the Reclassify tool. In the Contents pane, right click the SlopeReclass 
layer and select Attribute Table to view the new dataset.
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The Slope_Jezero_DTM layer displays slope values from 0° to 90°. The Reclassify tool grouped those values into 
three classes. The new classes have the values 1 (0°–5° slopes), 2 (5°–15° slopes), and 3 (slopes that are greater than [>] 15°). 
Through the reclassification process, the actual slope angles do not persist—instead, they are grouped into the three new classes. 
In the Attribute Table, you can view how many pixels are in each class. Class 1 (0°–5° slopes) are slopes that are gentle enough 
to be acceptable for a landing site. This class has the most pixels within the map area, followed by class 2 (non-ideal 5°–15° 
slopes) and class 3 (slopes that are >15° and are unacceptable for landing site selection).

10.	 In the SlopeReclass Attribute Table, click on the small box to the left of each object to select it and view the 
corresponding areas on the map.
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11.	 Once you are done exploring the new SlopeReclass Attribute Table, click on the Clear icon in the SlopeReclass 
Attribute Table tool bar to clear the selection, the click on the small x in the SlopeReclass Attribute Table tab to 
close it and return to the full map view.

12.	 In the Contents pane, uncheck the box for the Raster Functions group layer to turn it off and click on the small tri-
angle to collapse it. You do not need to view this group for the remainder of the geoprocessing tool analysis. You will 
return to it in part 2 for the raster function analysis.
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The new SlopeReclass layer is currently opaque and does not allow you to view the underlying CTX imagery 
(CTX_mosaic).

13.	 In the Contents pane, click on the SlopeReclass layer to select it. Then in the Effects section of the Raster Layer 
Appearance tab, set the transparency to 60%.

14.	 In the Contents pane, right click the SlopeReclass layer and select Symbology to update the colors for each class. In 
the Values table of the Symbology pane (the lower portion of the Symbology pane), click on each small colored box 
to set the colors for the classes. The new colors should be set to Solar Yellow (class 1), Tourmaline Green (class 2), 
and Ultra Blue (class 3). As you change the colors, you will see them update in the Contents pane SlopeReclass layer 
symbology and in the map itself.
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15.	 In the Values tab of the Symbology pane, click on the text in the Label column to update each class label. New class 
labels should be < 5 for class 1, 5 – 15 for class 2, and > 15 for class 3. Press enter to apply each new label. As you 
update the labels, you will see them change in the Contents pane SlopeReclass layer symbology.
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16.	 Once you have finished updating the SlopeReclass layer symbology, click on the small x in the upper right corner of 
the Symbology pane to close it and return to the Geoprocessing pane.

In the Geoprocessing pane, the Reclassify tool will still be open from your earlier analysis. You will run the Reclassify 
tool a second time, using the Jezero_DTM layer as the input. This second Reclassify analysis will identify areas that are above 
and below the elevation threshold for a safe landing site.

17.	 In the Reclassify tool pane, set the following inputs:

Input raster: Jezero_DTM

Reclass field: Value

Output raster: PlanetaryImageAnalysis_Exercise_4.gdb\ElevationReclass

18.	 When you changed the Input Raster, the Reclassification options reset to a blank table. To set the Reclassification 
options, click on Classify, located below the table. Then set the Number of classes to 2 and click OK.
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19.	 The new classes will be assigned default values. Click in the table and edit the Start and End values to set the 
following inputs:

Reclassification:
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Earlier, when you ran the Reclassify tool on the Slope_Jezero_DTM layer, classes had already been established through 
the symbology. No classes have been identified for the Jezero_DTM layer so the initial Reclassification table was empty. 
The values you have entered here are based on the elevation range within your region of interest (the 268-m maximum and 
the -4,283-m minimum elevation values can be found in the Contents pane under the Jezero_DTM layer symbology). For 
landing sites, acceptable locations must be located at elevations that are -1,000 m or lower (the new class 1) to provide enough 
atmosphere for aerobraking. All elevations that lie above -1,000 m are unacceptable and will be separated into class 2.
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20.	 In the Reclassify tool pane, click Run to create the new ElevationReclass layer.
The ElevationReclass dataset will be added to the map as a new layer.
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21.	 In the Contents pane, click on the ElevationReclass layer and drag it into the GP Tool Process group. Then, in the 
Contents pane click on the ElevationReclass layer to select it and change the transparency to 60% (located in the 
Raster Layer Appearance tab).

22.	 In the Contents pane, right click the ElevationReclass layer and select Symbology to update the colors for each 
class. In the Values table of the Symbology pane, click on each small colored box to set the colors for the classes. 
The new colors should be set to Solar Yellow (class 1) and Ultra Blue (class 2). Then, in the Values tab of the 
Symbology pane, change the class Labels to Below -1000 meters (class 1), and Above -1000 meters (class 2). When 
you have finished, click on the small x in the upper right corner of the Symbology pane to close it and return to the 
Geoprocessing pane.
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So far, you have identified the areas with acceptable slopes (<5°) and elevation (below -1,000 m). However, these datasets 
need to be combined. To combine them and continue with the subsequent analysis steps, these results must first be converted to 
polygons.

23.	 In the upper left corner of the Geoprocessing pane, click on the back arrow to return to the Geoprocessing tool 
menu. Then search for Raster to Polygon and click on the Raster to Polygon tool to open it.
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24.	 In the Raster to Polygon tool, set the following parameters:

Input raster: SlopeReclass

Field: Value

Output polygon features: PlanetaryImageAnalysis_Exercise_4.gdb\Slope_Polygons

Uncheck the box for Simplify polygons.
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25.	 Click Run to create the Slope_Polygons layer.
The Slope_Polygons will be added to the map as a new layer. Next, repeat the process to create polygons for the 

ElevationReclass layer.
26.	 In the Raster to Polygon tool, set the following parameters:

Input raster: ElevationReclass

Field: Value

Output polygon features: PlanetaryImageAnalysis_Exercise_4.gdb\Elevation_Polygons

Uncheck the box for Simplify polygons.
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27.	 Click Run to create the Elevation_Polygons layer.
Both the Slope_Polygons and Elevation_Polygons layers have been added to your map.

28.	 In the Contents pane, click and drag and Slope_Polygons and Elevation_Polygons to the top of the GP Tool Process 
group. Then, in the Contents pane, click on the symbol box for the Elevation_Polygons layer to open the Format 
Polygon Symbol pane. In the Properties tab of the Format Polygon Symbol pane, change the Color to No Color 
and the Outline color to Solar Yellow. Leave the default line thickness of 0.7. Click Apply to update the Elevation_
Polygons symbol.

29.	 In the Contents pane, click on the symbol box for the Slope_Polygons layer to open the Format Polygon Symbol 
pane. In the Properties tab of the Format Polygon Symbol pane, change the Color to No Color and the Outline 
color to Ultra Blue. Leave the default line thickness of 0.7. Click Apply to update the Slope_Polygons symbol. Then 
click on the small x in the upper right corner of the Symbology pane to close it and return to the Geoprocessing pane.

30.	 In the Contents pane, uncheck the boxes for the ElevationReclass and SlopeReclass layers to turn them off.
Your map now shows the polygon boundaries for the Elevation_Polygons (yellow) and Slope_Polygons (blue) layers.
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Now that you have converted the slope and elevation analyses to polygons, these outputs can be combined to find areas 
that meet both the slope and elevation criteria for an acceptable landing site. There are several different data overlay options in 
ArcGIS Pro. For the purposes of this analysis, you will use the Union tool.

31.	 In the upper left corner of the Geoprocessing pane, click on the back arrow to return to the Geoprocessing tools 
menu. Search for Union and click on the Union tool to open it.
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32.	 In the Union tool, set the following parameters:

Input Features: Elevation_Polygons and Slope_Polygons

Output Feature Class: PlanetaryImageAnalysis_Exercise_4.gdb\Elevation_Slope_Union

Attributes To Join: All attributes
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33.	 Click Run to create the Elevation_Slope_Union dataset.
The Elevation_Slope_Union dataset will be added to the map as a new layer. This dataset combines the results from both 

the Elevation_Polygons and Slope_Polygons layers and can be used to identify areas which meet both the elevation and slope 
criteria for an acceptable landing site.

34.	 In the Contents pane, uncheck the boxes for the Elevation_Polygons and Slope_Polygons layers to turn them off. 
Then click and drag the Elevation_Slope_Union to the top of the GP Tool Process group. Click on the symbol for the 
Elevation_Slope_Union layer and change the Outline color to Solar Yellow and click Apply to update the symbol. 
Once the symbology has been updated, click on the small x in the upper right corner of the Symbology pane to close it 
and return to the Geoprocessing pane.

https://pro.arcgis.com/en/pro-app/latest/tool-reference/analysis/an-overview-of-the-overlay-toolset.htm
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35.	 In the Contents pane, right click on the Elevation_Slope_Union layer and select Attribute Table to open it and 
explore the data that resulted from the Union tool.

The Elevation_Slope_Union layer contains a combination of the Elevation_Polygons and Slope_Polygons attributes. You 
can see both of those features represented in the Attribute Table. The gridcode fields are the class values that were assigned in 
the reclassification steps you completed earlier.

36.	 Explore the gridcode values that exist in the Elevation_Slope_Union Attribute Table by right clicking the top of 
each gridcode column and selecting Sort Ascending. This will allow you to easily identify the maximum and mini-
mum values for these fields and confirm that the data was combined correctly.

There are two gridcode columns in the Elevation_Slope_Union Attribute Table: one for the Elevation_Polygons, and 
one for the Slope_Polygons. These two sets of polygons were combined in the order that you entered them in the Union tool. 
Here, the Elevation_Polygons were set as the first input to the Union tool, and the Elevation_Polygons attributes are listed first 
in the resulting Attribute Table.
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These Attribute Table fields can be renamed for better clarity in the upcoming steps.
37.	 In the Contents pane, right click on the Elevation_Slope_Union and select Design → Fields to open the Fields: 

Elevation_Slope_Union editing tab.
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In the Fields: Elevation_Slope_Union editing tab, you will see two fields with the Alias of gridcode. However, the formal 
Field Names are gridcode and gridcode_1.
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38.	 In the Fields: Elevation_Slope_Union editing tab, Click and hover over the Field Name for gridcode to activate and 
edit the text. Change this Field Name and the Alias to Elevation_Class and press enter to apply the changes.

men22-7579_fig 01

39.	 In the Fields: Elevation_Slope_Union editing tab, Click and hover over the Field Name for gridcode_1 to activate 
and edit the text. Change this Field Name and the Alias to Slope_Class and press enter to apply the changes.
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40.	 In the Changes section of the Fields tab, click on the Save icon to save these changes. Then click on the small x in the 
Fields: Elevation_Slope_Union tab to close it and return to the Elevation_Slope_Union Attribute Table.
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The Attribute Table field names have been updated to reflect your changes.
41.	 Click on the small x in the Elevation_Slope_Union Attribute Table tab to close it and return to the full map view.
When you created the SlopeReclass and ElevationReclass datasets a class value of 1 was used to identify areas that met 

the landing site criteria. All other classes represent areas that do not meet the landing site criteria. With these datasets combined 
into the Elevation_Slope_Union dataset, you may now search for areas which have a value of 1 for both the Elevation_Class 
and Slope_Class.

42.	 In the Contents pane, click on the Elevation_Slope_Union layer to select it. Then, in the Selection section of the 
Map tab, click on the Select By Attributes icon.
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43.	 In the Select By Attributes window, confirm the Input Rows is set to the Elevation_Slope_Union layer, and the 
Selection type is New Selection. Use the dropdown menu to define the first search as Where Elevation_Class is equal 
to 1. Then click the Add Clause icon and add a second clause to And Slope_Class is equal to 1.
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44.	 Click OK to run the Select By Attributes tool.
The Select By Attributes tool will select only areas of the Elevation_Slope_Union layer which have both an Elevation_

Class and Slope_Class of 1. These areas satisfy both the elevation and slope requirements for landing site selection. All other 
areas are either too steep, too high, or both.
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45.	 In the Contents pane, right click the Elevation_Slope_Union layer and select Data → Export Features.
As you learned in Exercise 3, the Export Features tool will output only the features that are currently selected in a layer, or 

all the features in the layer if none are currently selected.
46.	 In the Export Features tool, set the following parameters:

Input Features: Elevation_Slope_Union

Output Location: PlanetaryImageAnalysis_Exercise_4.gdb

Output Name: Acceptable_Terrain_Regions

Leave all other defaults.

(Note: As an alternative to the previous Select By Attribute step, you can also build the expression to select and export 
only the features which have an Elevation_Class and Slope_Class value of 1 in the Export Features tool itself.)
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47.	 Click OK to export the selected features and create the Acceptable_Terrain_Regions layer.
The Acceptable_Terrain_Regions features will be added to the map as a new layer.

48.	 In the Selection section of the Map tab, click on the Clear icon to clear the selection. Then, in the Contents pane, 
click and drag and Acceptable_Terrain_Regions layer into the top of the GP Tool Process group.

49.	 In the Contents pane, click on the symbol for the Acceptable_Terrain_Regions layer to open the Format Polygon 
Symbol pane. In the Properties tab of the Format Polygon Symbol pane, change the Color to Cretan Blue and the 
Outline color to No Color and click Apply. Then click on the small x in the upper right corner of the Symbology 
pane to close it and return to the Geoprocessing pane.

50.	 In the Contents pane, click on the Acceptable_Terrain_Regions layer to select it. Then set the transparency to 60% 
(in the Raster Layer Appearance tab)
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51.	 Take a minute to explore the Acceptable_Terrain_Regions layer relative to the Elevation_Polygons and Slope_
Polygons. Zoom and pan through your map while turning layers on and off to see how these layers compare. When 
you have finished, turn off the Elevation_Slope_Union, Elevation_Polygons, and Slope_Polygons layers and return 
to the full extent of your area of interest (Zoom to Layer in the Contents pane). The only layers that should be visible 
when you continue are the CTX_mosaic and the Acceptable_Terrain_Regions layers. All other layers should be off.

The Acceptable_Terrain_Regions layer shows areas that meet both the elevation and slope criteria for landing site selection. The 
next step in the process is to identify areas within this layer which are large enough to accommodate a 12-km-diameter landing ellipse.
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52.	 In the upper left corner of the Geoprocessing pane, click on the back arrow to return to the Geoprocessing tools 
menu. Then search for Buffer and click on the Buffer tool to open it.
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53.	 In the Buffer tool, set the following parameters:

Input Features: Acceptable_Terrain_Regions

Output Feature Class: PlanetaryImageAnalysis_Exercise_4.gdb\NegBuffer

Distance: Linear Unit, -6 Kilometers

Side Type: Full

Method: Geodesic (shape preserving)

Dissolve Type: Dissolve all output features into a single feature
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By setting the Distance value to -6 km, the Buffer tool will remove all areas that are within 6 km of the polygon boundary. 
Typical landing ellipses for Mars have a 6-km radius, and the entire landing ellipse must have suitable terrain. Any areas of 
the Acceptable_Terrain_Regions polygon that are within 6 km of the polygon boundary will not have acceptable terrain for a 
landing ellipse throughout an entire landing ellipse and should therefore be removed from consideration.

54.	 Click Run to complete the Buffer tool and create the NegBuffer layer.
The NegBuffer result will be added to your map as a new layer. However, the Buffer tool must be run once more to 

encompass all the areas that can fit a landing ellipse.
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55.	 In the Buffer tool, set the following parameters:

Input Features: NegBuffer

Output Feature Class: PlanetaryImageAnalysis_Exercise_4.gdb\Potential_Landing_Sites

Distance: Linear Unit, 6 Kilometers (this time you are running it with a positive 6 km distance)

Side Type: Full

Method: Geodesic (shape preserving)

Dissolve Type: Dissolve all output features into a single feature
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The previous buffering step removed areas that were too small to fit a 12-km diameter landing ellipse. However, the 6 km 
must be added back on to the remaining regions to result in a polygon that has all the possible landing site options.

56.	 In the Buffer tool, click Run to create the Potential_Landing_Sites dataset.
The Potential_Landing_Sites result will be added to your map as a new layer.
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57.	 In the Contents pane, click on the Potential_Landing_Sites and NegBuffer layers and drag them into the top of the GP 
Tool Process group. Then uncheck the box for the NegBuffer and Acceptable_Terrain_Regions layers to turn them off.
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The Potential_Landing_Sites layer contains the areas around Jezero crater that meet the slope and elevation criteria for a 
safe landing site and are also large enough to hold a 12-km diameter landing ellipse.

58.	 Click on the small x in the upper right corner of the Buffer tool to close the Geoprocessing pane and return to the 
Catalog pane.

59.	 In the Catalog pane, right click on the Mars2020_Landing_Ellipse feature (located in Folders → 
PlanetaryImageAnalysis\Exercise_4\PlanetaryImageAnalysis_Exercise_4.gdb) and select Add To Current Map.

60.	 In the Contents pane, click on the Mars2020_Landing_Ellipse symbol to open the Format Polygon Symbol tool. In the 
Properties tab of the Format Polygon Symbol pane, change the Color to No Color and the Outline color to Black. Then 
click Apply to update the symbol and click on the small x in the upper right corner of the Symbology pane to close it.
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61.	 Take a minute to explore your map and analysis results and see how they compare to the final landing site for the Mars 
2020 rover in Jezero crater.

https://mars.nasa.gov/mars2020/mission/science/landing-site/
https://mars.nasa.gov/mars2020/mission/science/landing-site/


136    User’s Guide to Planetary Image Analysis and Geologic Mapping in ArcGIS Pro

62.	 When you have finished exploring the landing site assessment results, in the Contents pane, uncheck the box and click on 
the small triangle next to the GP Tool Process group to collapse it and turn those layers off. Then uncheck the box for the 
Mars2020_Landing_Ellipse layer to turn it off. Your map should now only show the CTX_mosaic layer. Return to the 
full extent of the CTX_mosaic layer (Contents pane → Zoom to Layer) before beginning the next section.

Part 2: Analysis with Raster Functions

In the previous steps, you completed a landing site assessment using geoprocessing tools. Here, you will repeat this assessment, 
but this time you will use raster functions and create a custom raster function. Once the assessment is complete, you can compare the 
outputs.

63.	 In the Contents pane, click on the small triangle to expand the Raster Functions group layer you created earlier. All 
outputs from this section will be placed in this group. Check the box to turn the Raster Functions group on.

In Exercise 2, you created the Slope_Jezero_DTM layer using a raster function. That layer should still be turned on and now 
visible in your map. (Note: If you unchecked the box to turn the Slope_Jezero_DTM layer off earlier, check it now to turn it back on.)

64.	 In the Contents pane, click on the Slope_Jezero_DTM layer to select it. Then, in the Analysis section of the Imagery 
tab, click on the Raster Functions icon to open the Raster Functions pane.

65.	 In the Raster Functions pane, search for Remap. Then click on the Remap icon to open the Remap raster function.
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66.	 In the Remap raster function pane, set the following parameters:

Raster: Slope_Jezero_DTM

Remap Definition Type: List

Table entries:		  Row 1 = 0 – 5, output 1

				   Row 2 = 5 – 90, output 0

				   (Note: To delete row 3 of the table, hover over the 3 and click the x that appears.)
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67.	 In the Remap raster function, click Create new layer to run the analysis.
The Remap_Slope_Jezero_DTM result will be added to your map as a new layer.

68.	 In the Raster Functions pane, click on the Remap icon again to reopen the tool. Then set the following parameters:

Raster: Jezero_DTM

Remap Definition Type: List

Table entries:		  Row 1 = -4283 to -1000, output 1

				   Row 2 = -1000 to 268, output 0

				   (Note: to create a new row, click in the Minimum value box in the * row and begin typing)
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69.	 In the Remap raster function, click Create new layer to run the analysis.
The Remap_Jezero_DTM result will be added to your map as a new layer.

70.	 In the Contents pane, click and drag the Remap_Jezero_DTM and Remap_Slope_Jezero_DTM layers into the top 
pf the Raster Functions group. Uncheck the box next to the Slope_Jezero_DTM layer to turn it off.

71.	 In the Contents pane, right click on the Remap_Jezero_DTM layer and select Symbology to open the Symbology 
pane. Set the Primary Symbology to Classify and select the Cividis color scheme (Note: you may need to check the 
boxes to Show names in the Color scheme dropdown menu).

72.	 In the Classes tab of the Symbology pane, set the Upper value for the second (yellow) class to 1. Then change the 
Label for the first (blue) class to Unacceptable, and the second (yellow) class to Acceptable.
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73.	 In the Effects section of the Raster Layer Appearance tab, set the transparency to 60%.
Now that you have formatted the symbology and display properties of the Remap_Jezero_DTM layer, you will repeat 

these steps to format the Remap_Slope_Jezero_DTM layer.
74.	 In the Contents pane, click on the Remap_Slope_Jezero_DTM layer to select it. When you select this new layer, the 

Symbology pane will automatically update to display the options and current settings for the selected layer.

75.	 In the Symbology pane, Set the Primary Symbology to Classify and select the Cividis color scheme. Then, in the 
Classes tab of the Symbology pane, change the Label for the first (blue) class to Unacceptable, and the second (yel-
low) class to Acceptable. Then click on the small x in the upper right corner of the Symbology pane to close it and 
return to the Raster Functions pane.

76.	 In the Effects section of the Raster Layer Appearance tab, set the transparency to 60%.
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You now have two layers which represent the areas with acceptable slopes (Remap_Slope_Jezero_DTM) and acceptable 
elevations (Remap_Jezero_DTM) for a landing site. The next step is to combine these layers and find areas which have both 
acceptable slopes and acceptable elevations.

77.	 In the Raster Functions pane, search for Boolean And. Then click on the Boolean And icon to open the raster function.
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78.	 In the Boolean And raster function, set the following parameters:

Raster: Remap_Jezero_DTM

Raster2: Remap_Slope_Jezero_DTM

Leave other defaults.
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79.	 In the Boolean And raster function, click Create new layer to run the analysis.
When the raster function is complete, the new Boolean_And_Remap_Jezero_DTM_Remap_Slope_Jezero_DTM layer 

will be added to your map. The Boolean And raster function identifies areas which have a value of 1 (acceptable terrain) in both 
input rasters.

80.	 In the Contents pane, click and drag the Boolean_And_Remap_Jezero_DTM_Remap_Slope_Jezero_DTM layer 
into the top of the Raster Functions group. Then right click on the layer name and select Symbology. Format the 
Symbology following the same process as you did for the Remap_Jezero_DTM and Remap_Slope_Jezero_DTM 
layers and set the transparency to 60%.
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81.	 In the Contents pane, uncheck the boxes for the Remap_Jezero_DTM and Remap_Slope_Jezero_DTM layers to turn 
them off. Then click on the small triangle to expand the GP Tool Process group and check the box to turn it on. In the GP 
Tool Process group, turn off the Potential_Landing_Sites layer and turn the Acceptable_Terrain_Regions layer on.
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82.	 Take a moment to compare these two layers. In the Contents pane, click on the Acceptable_Terrain_Regions layer to 
select it. Then in the Effects section of the Feature Layer Appearance tab, click on the Swipe  icon. With the Swipe 
tool enabled, click near the top of your map and drag the pointer down to swipe the Acceptable_Terrain_Regions on 
and off. (Note: The Swipe tool will work on whichever layer is currently selected in the Contents pane.)

Note: The next step in the landing site assessment (buffering) begins working with vector data, which is not what raster 
functions are used for. To continue the landing site assessment from this point, you would use the Raster to Polygon 
geoprocessing tool to turn this raster function output into a polygon feature class. However, you can use raster functions (or 
your own custom raster function that you will create in the next section) to identify regions with acceptable terrain and quickly 
complete the first half of the analysis.

Part 3: Create a Custom Raster Function

Your map now contains two layers showing all the areas that meet both the elevation and slope requirements for a landing 
site. However, one (Acceptable_Terrain_Regions) was created using only geoprocessing tools, and the other (Boolean_And_
Remap_Jezero_DTM_Remap_Slope_Jezero_DTM) was created using only raster functions. The raster function steps you 
took to get to this point may be saved and used to create a custom raster function which can be used at any time to quickly 
complete this analysis in only one step.

83.	 In the Contents pane, uncheck the box for the GP Tool Process group and collapse the group. Then right click the 
Boolean_And_Remap_Jezero_DTM_Remap_Slope_Jezero_DTM layer and select Save Function Chain.
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This will open the Raster Function Template tab, which shows all the raster function steps you took to get to this point in 
your analysis. Here, you can view and edit the processing steps, and save this process as a custom raster function. Settings and 
thresholds for individual steps in the process (like Remap) can be changed by double clicking on the function boxes. For now, 
you will keep those settings the same, but they can be changed even after the custom raster function is saved. More information 
on working in the Raster Function Template is available from Esri here.
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When saving a custom raster function, you will often want to make certain inputs and settings available to the user. In this 
example, you will need to make the starting raster dataset (the DTM) available to the user to set their own input raster.

84.	 In the Raster Function Template, double click on the Slope box to open the options for this step. Then switch to the 
Variables tab in the Slope Properties window.
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The Variables tab is where you may define which parameters are visible to the user (IsPublic) as inputs.
85.	 In the Variables tab of the Slope Properties window, check the box for the DEM Parameter. This will allow the user 

to input the DEM of their choice when running the custom raster function. Then click OK to exit the Slope Properties 
window.

https://pro.arcgis.com/en/pro-app/latest/help/analysis/raster-functions/raster-function-template.htm
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Since the same DEM feeds into both branches of the custom raster function, you only need to make one of these inputs 
public. If you were making a custom raster function which relied on additional data inputs, you would need to make those public 
as well.

86.	 In the Raster Function Template toolbar, click on the Save As  icon to save a new custom raster function.
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87.	 In the Save As window, set the following parameters:

Name: 		  Landing Site Terrain Assessment

Category:		  Custom

				   Selecting Custom will make your custom function available in any ArcGIS Pro project, not 	
				   just the current project.

Sub-Category: 	 Custom1

				   You can create your own categories within your custom raster function menu. This is the 		
				   default setting.

	Description: 		  Terrain assessment for landing sites. Analyzes terrain for acceptable slopes and eleva	
				   tions using DTM input.

Leave all other defaults.
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88.	 Click OK to save your custom raster function. Then click on the small x in the Raster Function Template tab (now 
named Landing Site Terrain Assessment.rft.xml) to close it.

When you save your custom raster function, it will be automatically added to the Raster Functions menu, under the 
Custom tab, and the Raster Functions pane will open to the Custom tab to view it.

89.	 In the Raster Functions pane, clear the previous search by clicking on the small x in the right end of the search bar. 
You will then see the new custom Landing Site Terrain Assessment raster function listed.
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From here, you can run, edit, export, and share your custom raster function.
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90.	 To test the new Landing Site Terrain Assessment function, click on the icon to open it. Then set the input Raster to 
Jezero_DTM and click Create new layer.

With one click, the new Landing Site Terrain Assessment function will run all the same steps you took to create the 
Boolean_And_Remap_Jezero_DTM_Remap_Slope_Jezero_DTM layer, and that new output will be added to your map as 
the Landing Site Terrain Assessment_Jezero_DTM layer.
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91.	 In the Contents pane, click and drag the Landing Site Terrain Assessment_Jezero_DTM layer into the top of the 
Raster Functions group. Then, with the Landing Site Terrain Assessment_Jezero_DTM layer selected, turn on the 
Swipe tool (in the Effects section of the Raster Layer Appearance tab) and compare this new custom raster function 
output to the Boolean_And_Remap_Jezero_DTM_Remap_Slope_Jezero_DTM layer, which you produced through 
individual raster function steps. You may also want to set the transparency of this new Landing Site Terrain Assess-
ment_Jezero_DTM layer to 60% for easier comparison.
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You now have your own custom raster function which can be used at any time to quickly and easily complete a slope and 
elevation landing site terrain assessment. You can also share this custom function with others. Custom raster functions can be 
particularly helpful to streamline and automate analyses or processes which you do frequently. Through sharing, custom raster 
functions can also be used to ensure that multiple people are using the same methods and settings in their processing steps.

92.	 In the Contents pane, uncheck the box for the Raster Functions group turn these layers off and click on the small 
triangle to collapse the group. Your map should once again show only the CTX_mosaic layer.

Part 4: Landing Site Assessment with a Custom Raster Function

In the previous section you created a custom raster function which will complete a landing site assessment and identify 
areas with acceptable slopes and elevations. In this activity, you will use that custom raster function to quickly complete a larger 
scale landing site assessment for Mars.

93.	 In the Contents pane, right click Map and select New Group Layer. Name this new group layer Landing Site 
Assessment.

To complete the landing site assessment, you will work with a larger dataset than just the region around Jezero crater.
94.	 In the Contents pane, uncheck the box for the CTX_mosaic layer to turn it off. Then check the box to turn the Syrtis 

DTM layer on. Then, in the Contents pane, right click the Syrtis DTM layer and select Zoom to Layer.

95.	 At the bottom of the Raster Functions pane, click on the Catalog tab to return to the Catalog pane. Then switch to 
the Portal tab of the Catalog pane and click on the ArcGIS Online  icon to search the entire ArcGIS Online portal.
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The only required input to your custom Landing Site Terrain Assessment raster function is the DTM, but it is often 
helpful to have base imagery for additional context. A global mosaic of CTX imagery is available from the California Institute of 
Technology (Caltech) through the ArcGIS Online portal and can be added directly to your map.

96.	 In the Portal tab of the Catalog pane, search the ArcGIS Online portal for Mars CTX. In the search results, right 
click the Mars CTX (beta01) Image Mosaic Tile Layer (owner: esri_astro, credit: NASA, JPL, MSSS, Caltech 
Murray Lab, Esri) and select Add to Current Map. Once the layer has been added to your map, in the Contents pane, 
click and drag it into the Rasters group, putting it just below the Syrtis DTM layer.
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The Caltech Mars CTX (beta01) Image Mosaic is one of several Mars global datasets which are available for use through 
the ArcGIS Online portal. Also available are the Mars HiRISE Image Mosaic, the Mars HRSC-MOLA Terrain (elevation layer), 
the Mars HRSC-MOLA Colorized Shaded Relief, and the Mars MDIM 2.1 Colorized Global Image Mosaic datasets. These 
datasets are freely available for anyone to view and use in their GIS projects.

97.	 At the bottom of the Catalog pane, click on the Raster Functions tab to return to the Raster Functions pane.
The custom Landing Site Terrain Assessment raster function was created from the processing steps used in the analysis 

of the Jezero region. Before running this custom raster function on a broader Mars dataset, you must first update the maximum 
and minimum elevation values to reflect all the elevations which are present in the study area. These values can be identified 
by looking in the Contents pane at the Syrtis DTM symbology. (Note: you may have to expand the Syrtis DTM layer in the 
Contents pane to view the symbology details.)
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http://murray-lab.caltech.edu/CTX/
https://www.arcgis.com/home/item.html?id=e6c448d134404fc082c73678accca7e5
https://www.arcgis.com/home/item.html?id=c1c4c750a2154842ae523c984cc14fa5
https://www.arcgis.com/home/item.html?id=225adad86379474ebc3d51a74573c99b
https://www.arcgis.com/home/item.html?id=07b33bb3067747abbebd1ce34c29816e
https://www.arcgis.com/home/item.html?id=1efb16809db84f0c892b9b0662dab0c8
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For this analysis, you could update the maximum and minimum elevation values to match only those that are present in 
the Syrtis DTM region. However, to make the custom raster function more versatile for future use, you will instead update the 
elevations to encompass all of Mars (-8,324 m to 21,078 m).

98.	 In the Custom tab of the Raster Functions pane, right click the Landing Site Terrain Assessment icon and select 
Edit. This will open the Raster Function Template.

The Landing Site Terrain Assessment function contains two Remap steps: one for slope, and one for elevation.
99.	 In the Raster Function Template, double click on the Remap block which has the Raster as a direct input. This is the 

elevation Remap step.
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100.	 In the Remap Properties window, update the Minimum and Maximum elevation values to reflect the minimum and 
maximum elevation values on Mars (see example Mars Global DTM values in the image below). Then click OK to 
close the Remap Properties window.
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101.	 In the Raster Function Template toolbar, click on the Save  icon to update the custom raster function. Then click on 
the small x in the Raster Function Template tab to close it and return to the full map view.

Now that you have updated the elevation values in the custom raster function, it can be used for any location on Mars, or all 
of Mars.

102.	 In the Custom tab of the Raster Functions menu, click on the Landing Site Terrain Assessment icon to open the 
custom raster function. Set the input Raster to the Syrtis DTM and click Create new layer to run the analysis.
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103.	 In the Contents pane, click and drag the new Landing Site Terrain Assessment_Syrtis DTM layer into the Landing 
Site Assessment group. Then click on the small triangle to expand and view the contents of the Landing Site Assessment 
group. Select the new Landing Site Terrain Assessment_Syrtis DTM layer and set the transparency to 60%.
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104.	 In the Contents pane, right click the Landing Site Terrain Assessment_Syrtis DTM layer and select Symbology. In 
the Symbology pane, set the Color scheme to Cividis. Then click on the small x in the upper right corner of the Sym-
bology pane to close it. In the Contents pane, uncheck the box for the Syrtis DTM to turn the layer off.
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Your map now contains an assessment of slopes and elevations across the whole Syrtis region and has identified areas that 
have both slopes between 0°–5° and elevations of -1,000 m or lower. These areas are highlighted in yellow.

105.	 Take a minute to zoom and pan through your map and explore the outputs from your custom Landing Site Terrain 
Assessment raster function.

As you explore the map, remember that raster functions process data on the fly, and the results will update every time you 
move the map and (or) zoom, so the raster function is only processing the pixels you are currently viewing.
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Summary

In this exercise you learned how to complete a multi-step analysis in ArcGIS Pro using two different methods: geoprocessing 
tools, and raster functions. Geoprocessing tools and raster functions can both be used for analysis but work in different ways. 
Geoprocessing tools analyze datasets and put the resulting product into new data layers. These new data are saved on your 
computer. Raster functions apply an analysis directly to the pixels of a dataset, but those shown within the current view and only at 
the current scale. Raster functions produce temporary map layers instead of creating new permanent files. You also learned how to 
string several raster functions together to create and save a custom raster function. These custom raster functions can be used later 
by you and others with whom you share them. Once your custom landing site assessment raster function was created, you then used 
it to quickly complete a large-scale landing site assessment for the Syrtis region of Mars. This example landing site assessment 
activity follows the same basic techniques that you would use to conduct data analyses of all types.

To Prepare for the Next Exercise:

If you wish to start with a fresh GIS project for Exercise 5, click the x in the upper right corner of your ArcGIS Pro window 
to close it. Alternatively, if you prefer to continue working in this GIS project, complete the following steps before moving on to 
Exercise 5: Click on the small x in the upper right corner of the Raster Functions pane to close it. Then, in the Contents pane, 
uncheck the boxes for the Landing Site Assessment group, and the Mars CTX (beta01) Image Mosaic to turn those layers 
off. Click on the small triangle next to the Landing Site Assessment group to collapse it. Then check the box to turn the CTX_
mosaic layer back on and zoom to the extent of the CTX_mosaic layer.



150    User’s Guide to Planetary Image Analysis and Geologic Mapping in ArcGIS Pro

Exercise 5: Creating Map Layouts and Products
When working in a GIS, you may need to present your findings or final map products in a layout form. Map layouts typically 

include objects like a legend, scale bar, title, and north arrow, and may also include multiple maps or variations of the same map. 
This exercise will introduce you to the basics of creating map layouts and GIS products in ArcGIS Pro. To learn more about the 
requirements for planetary maps published through the USGS, see the USGS Astrogeology Planetary Mapping Guidelines.

If you wish to continue working with the GIS project from Exercise 4 (PlanetaryImageAnalysis_Exercise_4.aprx) skip to 
step 2. If you prefer to start with a fresh GIS project, begin with step 1 below:

1.	 In your Windows File Explorer, navigate to the PlanetaryImageAnalysis\Exercise_5 folder and double click the 
PlanetaryImageAnalysis_Exercise_5 project file (.aprx) to open it in ArcGIS Pro.

The PlanetaryImageAnalysis_Exercise_5 project will open in ArcGIS Pro. Data has already been added to the map, and 
all map layers are listed in the Contents pane.

Part 1: Creating a New Map Layout

2.	 In the Project section of the Insert tab, click on the New Layout icon and then select the Custom page size option.
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USGS Scientific Investigation Maps (SIMs) are limited to 40ʺ×56ʺ. For this exercise, you will create a map layout with 
these dimensions.

3.	 In the Layout Properties window, set the Width to 56 in, and the Height to 40 in. Then click OK to create the new 
Layout.

https://www.usgs.gov/special-topics/planetary-geologic-mapping/current-planetary-mapping-guidelines
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A new blank map layout will be added to your ArcGIS Pro project. You will add maps to the layout using Map Frames.
4.	 In the Map Frames section of the Insert tab, click on the Map Frame icon and select the Default Extent option. 

Then, click and drag to draw a box in the Layout to create this new Map Frame.
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The new Map Frame has been added to the map. However, no map is visible within the Map Frame box.
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Part 2: Working with Map Frames

5.	 Right click inside the Map Frame and select Activate.
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By activating the Map Frame, you can now zoom and pan to adjust the display within the frame. This Map Frame acts as 
a miniature version of the Map display and can be manipulated in a similar manner as the Map itself.

6.	 With the Map Frame now activated, in the Contents pane, right click the CTX_mosaic layer and select Zoom to 
Layer. You will see the active Map Frame update to display the full extent of the CTX_mosaic layer.
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7.	 To deactivate the Map Frame, click on the small red x in the upper right corner of the Layout view.
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8.	 In the Layout, click once on the Map Frame to display the resizing handles. Then click and drag one corner to resize 
the Map Frame so it takes up the top left quarter of the Layout. Once you have resized the Map Frame, click inside 
the Map Frame boundary and drag the entire frame to relocate it to the bottom left corner of the layout.
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When you resize a Map Frame, the map displayed within its boundaries does not change in scale or location. Resizing a 
Map Frame will only show more or less of the map itself. To change the view within the Map Frame, you must first reactivate 
the Map Frame. Once the Map Frame has been activated, you may zoom and pan to make adjustments.

Part 3: Modifying Map Layers

The new Layout is displayed in the center of the ArcGIS Pro workspace as a new tab. Your Map is also displayed in this 
space as a tab, and you can switch back and forth between them. Like other components in ArcGIS Pro, you can also pull these 
tabs out from these locations and display them side by side, or as their own separate windows.

9.	 Click on the Layout tab and drag it away from its current location. Move your cursor around the main workspace until 
you see the docking options. Use the docking option on the right side of the main workspace to place the Layout and 
the Map side by side.
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Viewing the Layout and Map together (either docked side by side, or with the Layout pulled into its own window) can 
make it easier to manipulate layers in your Map, while watching how that changes your Layout.

10.	 In the Layout, right click anywhere in the page and select Zoom to Page. This will reset the Layout view, so the 
entire page is visible.
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Currently, the Layout tab is highlighted in blue, which indicates it is the active tab. You can switch between activating the 
Map and the Layout by clicking on their tabs or within their respective windows.

11.	 Click between the Map and the Layout tabs to observe how changing the active tab affects the tabs in the Menu Bar 
and the layers listed in the Contents pane. End with the Map tab activated.

12.	 With the Map tab activated, in the Contents pane, Check the box for the Jezero_DTM to turn the layer on. Observe 
how this affects the Map Frame in the Layout view.
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Each Map Frame is connected directly to a Map. Any changes that occur in the map (for example: changing visible 
layers), will also be seen in the Map Frame.

13.	 In the Contents pane, Check the box to turn on the Mars2020_Landing_Ellipse. Then expand the GP Tool 
Process group and check the box to turn the group on. The Acceptable_Terrain_Regions layer was left on and will 
automatically display when the group is made visible again. Uncheck the box for the Acceptable_Terrain_Regions 
to hide that layer and turn on the Potential_Landing_Sites layer instead. Then right click the Jezero_DTM layer and 
select Zoom to Layer so you can see the whole map area now that you are working in the side-by-side view.
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14.	 In the Layout, right click the Map Frame and select Activate. Then, in the Contents pane, right click the Jezero_
DTM layer and Zoom to Layer to fill the active Map Frame. Then click on the small red x box in the upper right 
corner of the Layout view to close the active Map Frame.
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Part 4: Adding Map Features

For a map to effectively convey information, it must contain a north arrow, scale bar, and legend. These features may all be 
added using the Insert tab.

15.	 Confirm that you have the Layout view selected. Then, in the Map Surrounds section of the Insert tab, click on 
the North Arrow icon to open the dropdown menu. Click on the ArcGIS North 1 arrow style to add it to the map 
Layout. When the crosshairs appear, click and drag in the map Layout to draw a box and place the north arrow.
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16.	 In the map Layout, use the handles to resize the north arrow. Then click and drag it to create the following result:
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17.	 In the Map Surrounds section of the Insert tab, click on the Scale Bar dropdown menu to view the scale bar format 
options. Select the Metric Alternating Scale Bar 1 format. When the crosshairs appear, click once in the Layout 
place the scale bar.

men22-7579_fig 01

men22-7579_fig 01

Scale bars are tied to one specific Map Frame contained in your layout. If you zoom in or out in the Map Frame, the 
scale bar will automatically update to reflect the new scale at which the Map Frame is being viewed. Scale bars will also 
automatically update as they themselves are resized.

18.	 Click and drag the scale bar into the bottom left corner of the Map Frame. Then use the handles to resize it until it is 
100 km long. For this step, you may need to zoom in to the Layout view to see more detail. When you have finished, 
right click in the Layout page and select Zoom to Page to return to the current full-page view.
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Part 5: Displaying Multiple Combinations of Data

When creating a Layout, you can include multiple Map Frames to show data at various scales, or entirely different 
datasets. If a Layout includes multiple Map Frames that reference the same Map, you can only display the same data with a 
different extent. As you turn layers on/off in that Map, it will update both Map Frames. To display a different combination of 
data, you must reference a different Map. For this Layout, you will also include a global map to provide context for your study 
area. To have a Map Frame show this global context map, you must first create a new map within the ArcGIS Pro project.

19.	 Click in the Map to activate that tab. Then, in the Project section of the Insert tab, click on the New Map icon to 
create a new map. The new map (Map1) will be added as a second tab in the map window and the Contents pane will 
update to display the contents of this new map.
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Because ArcGIS Pro is not specific to planetary science, all new maps open with Earth-based base maps by default.
20.	 In the Map1 Contents pane, right click each of the existing basemap layers and select Remove to remove them from 

your map. You should end with an empty map and no map layers listed in the Map1 Contents pane.
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21.	 In the Contents pane, click on Map1 and hover to activate the text. Rename Map1 to Global Mars. Press enter to 
apply this change. You will also see the map tab update to reflect the new map name.
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22.	 Click on the Map tab to return to your original map. Then, in the Contents pane, click and hover over Map to activate 
the text. Change the map name to Jezero Region and press enter to apply the change.
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23.	 Click on the Global Mars map tab to switch to work in this new map. Then, in the Catalog pane, switch to the 
ArcGIS Online section of the Portal tab and search for Mars MOLA shaded relief.
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24.	 In the search results, right click on the Mars HRSC-MOLA Colorized Shaded Relief tile layer and select Add To 
Current Map.
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The Mars HRSC-MOLA Colorized Shaded Relief dataset will be added to the Global Mars map as a new layer.
25.	 In the Contents pane of the Global Mars map, right click on the Mars HRSC-MOLA Colorized Shaded Relief 

layer and select Zoom to Layer to view the full extent of this dataset.
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Since the original new map was automatically assigned Earth-based base maps, it is important to confirm that the 
coordinate system of the Global Mars map itself was updated when this new data is added.

26.	 In the Contents pane of the Global Mars map, right click on the Global Mars map name and select Properties.
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27.	 In the Map Properties: Global Mars window, select the Coordinate Systems tab (down the left side of the window), 
and confirm that the coordinate system has updated to GCS_Mars_2000_Sphere. Then click OK to exit the Map 
Properties window.
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Now that you have created the Global Mars map, you can add Map Frames to the Layout to display it.
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28.	 Click in the Layout window to activate it. Then, in the Map Frames section of the Insert tab, click on the Map 
Frame icon to open the dropdown menu and observe the available options.
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The Map Frame options now display the updated map names (Global Mars and Jezero Region) and have both maps 
available as Map Frame data sources.

29.	 In the Map Frame options, select the Global Mars Default Extent option. Then draw a box to place it in the upper 
right corner of your Layout.

men22-7579_fig 01 men22-7579_fig 01

30.	 Right click in the new Map Frame and select Activate. Then, with the Map Frame activated, in the Contents pane, 
right click on the Mars HRSC-MOLA Colorized Shaded Relief layer and select Zoom to Layer to resize the data 
and fill the new Map Frame. Exit the active Map Frame by clicking on the small red x in the upper right corner of 
the Layout.
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Part 6: Displaying the Same Data at Different Scales

The Layout now includes a landing site assessment map (lower left), and a global context map (upper right). You will add 
a third Map Frame to show a detailed view of the landing site assessment results in the area around the final Mars 2020 landing 
site.

31.	 In the Map Frames section of the Insert tab, click on the Map Frame icon and select the Jezero Region Default 
Extent option. Then draw a box for this new Map Frame in the lower right corner of the Layout.
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32.	 Right click in the new Map Frame and select Activate. Then use the scroll wheel of your mouse to zoom in to the 
Mars2020_Landing_Ellipse and surrounding area. Once you have zoomed to this area, exit the active Map Frame by 
clicking on the small red x in the upper right corner of the Layout.
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Part 7: Making Changes to Existing Map Frames

With all three Map Frames added, you may find that you wish to change some of the layer display properties to improve 
the look of your Layout. At any time, you can turn map layers on and off and change the symbology and those changes will be 
automatically reflected in the Layout.

33.	 Click on the Jezero Region map tab to activate it. Then, in the Contents pane, uncheck the box to turn off the Jezero_
DTM layer. Observe how this change is automatically reflected in the Layout.
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34.	 In the Contents pane of the Jezero Region map, select the Potential_Landing_Sites layer, and set its transparency 
to 60% (in the Feature Layer Appearance tab). Then, in the Contents pane, click on the symbol for the Mars2020_
Landing_Ellipse layer to open the Format Polygon Symbol pane. Switch to the Properties tab of the Format 
Polygon Symbol pane and change the Outline width to 1.5 pt and click Apply. Then click on the small x in the upper 
right corner to exit the Format Polygon Symbol pane.
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With the map displays updated, you can now return to the Layout and continue adding elements. The detailed landing site 
Map Frame is at a different scale than the other landing site assessment frame and should have its own scale bar.

35.	 Click in the Layout to activate it. Then click on the detailed landing site Map Frame (bottom right corner) to select 
it. (Note: When placing a scale bar, it will automatically tie to whichever Map Frame was last selected, so it is best 
practice to select the Map Frame you want before placing the scale bar.) In the Map Surrounds section of the Insert 
tab, click on the Scale Bar dropdown menu to open the options and select the Metric Alternating Scale Bar 1. Then 
click once in the Layout to place the scale bar, then use the handles to resize it to 10-km-long and drag it to the bottom 
right corner of the lower right Map Frame. (Note: Like before, you may need to zoom in to see more detail when you 
are resizing the scale bar. When you have finished, right click in the Layout page and select Zoom to Page to return to 
the full view.) You should end with this Layout result:
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With all the Map Frames placed in the Layout, you may find you wish to adjust their locations or sizes to better fit the 
Layout space.
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36.	 In the Layout, click on the lower left Map Frame to select it. Then use the handles to drag the top boundary up to the 
bottom of the upper left (global map) Map Frame. Repeat this step for the lower right Map Frame.
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37.	 In the Layout, click and drag the North Arrow to move it to the blank space in the upper left corner.
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Now that the Map Frames are their final desired sizes, you may need to adjust the maps displayed within their boundaries.
38.	 Right click on the lower left Map Frame and select Activate. Then, in the Contents pane, right click on the Potential_

Landing_Sites layer and select Zoom to Layer to fill the Map Frame. When you have finished, click on the small red x 
in the upper right corner of the Layout to exit the active Map Frame. Then zoom in to this Map Frame to observe how 
this change affected the scale bar. When you have finished, return to the full Layout extent (Zoom to Page).
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Part 8: Adding and Editing a Title and Map Legend

In addition to scale bars and a north arrow, effective maps also include a Legend.
39.	 In the Map Surrounds section of the Insert tab, click on the Legend icon. Then, in the Layout, click and drag to 

draw a box and place the Legend.
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40.	 In the Layout, zoom in to view the Legend.
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Often, the default configuration for the Legend will include items you do not want listed, like the Image pixel values shown 
above.

41.	 In the Layout, double click in the Legend box to open the Format Legend pane. Then, under Legend Items, click 
on the Show Properties… button. The Legend Items will then be listed in the Contents pane. In the Contents pane 
under Legend, uncheck the box for the Image to remove it from the Legend.
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42.	 In the upper left corner of the Legend Item pane, click on the back arrow to return to the Format Legend pane. Then 
click on the Text Symbol tab and expand the Appearance section. Set the Size to 36 pt and click Apply to update 
the Legend font. When you have finished, click on the small x in the upper right corner of the Format Legend pane 
to close it. Then, in the Layout use the handles on the Legend box to resize it to fit the new font size and return to the 
full-page extent (Zoom to Page). Click and drag to place the Legend in the bottom right corner of the open space.
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43.	 To add a title to the Layout, in the Graphics and Text section of the Insert tab, click on the Rectangle text  icon. 
Then click and drag in the Layout to draw a box for the title.
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44.	 In the Layout, use the scroll wheel of your mouse to zoom in so the text is visible. Then, enter Jezero crater and Nili 
Planum Landing Site Assessment for the title, then click outside the text box to apply this change. Right click in the 
Layout and Zoom to Page to view the full extent of the Layout.
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The default text setting has a font size that is too small for your Layout.
45.	 To edit the text, double click on the text box. This will open the Format Text pane. In the Format Text pane, switch 

to the Text Symbol tab and change the Size to 120 pt. Expand the Position section and change the Horizontal 
Alignment to Centered. Then click Apply to update the font. When you are done, click on the small x in the upper 
right corner of the Format Text pane to close it. Return to the Layout and use the handles to resize the text box to fit 
in the blank space in the upper right corner of the Layout.

men22-7579_fig 01

Part 9: Adding a Location Box to the Context Map

The final component to add to your Layout is a context box to show the location of the study area on the global map. The box can 
be drawn manually using the drawing tools in the Graphics and Text section of the Insert tab. However, in this example you can also 
use the boundary box from the CTX_mosaic layer since that marks the full extent of the study area and will provide the most accuracy.
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46.	 Click on the Jezero Region map to activate it. Then, in the Contents pane right click the CTX_mosaic layer and 
select Copy. Switch to the Global Mars map tab. In the Contents pane, right click on the Global Mars map title and 
select Paste to paste this layer to the global map.
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47.	 In the Contents pane for the Global Mars map, click on the small triangle to expand the CTX_mosaic layer. Then 
uncheck the box to turn the Image off and check the box to turn the Boundary on. Click on the Boundary symbol 
to open the Format Polygon Symbol pane. Switch to the Properties tab of the Format Polygon Symbol pane and 
change the Outline color to Black and the Outline width to 2 pt. Click Apply to update the symbology. Then click 
on the small x in the upper right corner of the Format Polygon Symbol pane to close it.
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48.	 Your Layout is now complete. Click and drag the Layout tab back to join the Jezero Region and Global Mars tabs 
so you can get a full screen view.
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Summary

In this exercise you learned how to create and edit a basic map Layout in ArcGIS Pro, including adding a North Arrow, 
Legend, Map Title, and multiple Map Frames with Scale Bars. While creating a Layout for your Jezero crater and Nili 
Planum landing site assessment results you learned how to manipulate the map layers and display options which are then 
reflected in the map Layout. You also learned how to use Map Frames to display different combinations of datasets in the 
same layout by creating additional Maps within your ArcGIS Pro project. There are many additional options and capabilities for 
creating Layouts beyond those which you explored in this activity. For additional guidance on planetary geologic mapping and 
formatting your map products, see the USGS Astrogeology Planetary Mapping Guidelines.

https://www.usgs.gov/special-topics/planetary-geologic-mapping/current-planetary-mapping-guidelines
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Appendix 1: Additional Resources
Cornell University Library GIS

The Cornell University Library provides a variety of Geographic Information System (GIS) support services. This 
website will help you access GIS software and learn how to use it, find geospatial data, connect with GIS user groups, 
and get help when you need it.

Cornell University Spacecraft Planetary Image Facility (SPIF)
The Spacecraft Planetary Image Facility (SPIF) at Cornell University provides research support by assisting 

students and planetary scientists in their research, and by providing outreach services and educational support 
throughout the Central New York region and beyond.

Esri Corporation GIS Dictionary
Terms related to specific GIS operations, cartography, and Esri technology.

Esri Corporation GIS Bibliography
A broad and searchable collection of GIS literature from early GIS to present day.

Mapping and Planetary Spatial Infrastructure Team (MAPSIT)
Focuses on the use, functionality, and availability of planetary data. MAPSIT is comprised of members of the 

planetary science community and actively solicits input from the community to report to the National Aeronautics and 
Space Administration (NASA) as requested.

NASA EarthData: Geographic Information Systems (GIS)
An overview of GIS topics from NASA’s EarthData program, including tools and tutorials and links to datasets.

Tennessee Tech Sedimentary Research Group GIS Tutorials
Includes multiple tutorials for planetary geologic mapping in ArcGIS Pro.

USGS (U.S. Geological Survey) Astrogeology Science Center Glossary of Terms
Terms related to planetary science, remote sensing, and data processing.

USGS Astrogeology Science Center MRCTR Lab
The USGS Astrogeology Mapping, Remote-sensing, Cartography, Technology, and Research (MRCTR, 

pronounced “Mercator”) GIS Lab provides web-based resources aimed at the planetary research community. The 
lab supports GIS graphical, statistical, and spatial tools for analyses of planetary data, including the distribution of 
planetary GIS tutorials, tools, programs, and information. USGS maintains planetary GIS databases consisting of peer-
reviewed digital geologic maps, feature maps, topography, and remote-sensing data under the scientific oversight of the 
NASA Geologic Mapping Subcommittee (GEMS). The lab also supports and encourages geospatial open standards. 
This website includes GIS tools, tutorials, and data.

USGS Planetary Geologic Mapping GIS Hub
Website with links to USGS datasets and GIS tools.

https://guides.library.cornell.edu/gis
https://cornellspif.com/
https://support.esri.com/en-us/gis-dictionary
https://gis.library.esri.com/
https://www.lpi.usra.edu/mapsit/
https://earthdata.nasa.gov/learn/gis
https://tntechsedgeology.org/tutorials/
https://www.usgs.gov/centers/astrogeology-science-center/glossary-terms
https://www.usgs.gov/special-topics/planetary-geologic-mapping/mapping-and-gis-resources
https://astrogeology-usgs.hub.arcgis.com/
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Appendix 2: Metadata
By default, ArcGIS Pro uses its own Item Description metadata profile (ArcGIS Pro Help/Metadata), which can be translated 

into a variety of standards, but users can select a specific metadata standard in the Options window, accessed through the Project 
menu. U.S. Federal data catalogs require either Federal Geographic Data Committee (FGDC) Content Standard for Digital 
Geospatial Metadata (CSDGM) or ISO 19115-3 compliant metadata. To make changes to these fields (Edit, Import or Update) 
users must navigate to the source dataset through the Project tab of the Catalog inset window, and select Edit Metadata.
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Many common image formats, like the GeoTIFF’s in this tutorial, have their core metadata encoded directly into the file, but 
may also include supplemental metadata in a separate (sidecar) file. These files usually have the same base name and a different 
extension (for example, *.xml, or *.json), and are read automatically by ArcGIS. These files may contain more robust metadata. 
Raw image formats may also include a detached label containing essential geospatial metadata (*.lbl). Because metadata is often 
included in a separate, supplemental file, it is important to include all relevant files when copying or sharing images.

men22-7579_fig 01

https://pro.arcgis.com/en/pro-app/latest/help/metadata/create-iso-19115-1-and-iso-19115-3-metadata.htm
https://www.fgdc.gov/metadata/csdgm-standard
https://www.fgdc.gov/metadata/csdgm-standard
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For data to be released for community or public use it is important that it is described as thoroughly as possible. One way 
to do this is to create an entire metadata record completely within ArcGIS Pro. For metadata requiring augmentation, users can 
capture machine-readable geospatial and schema information, which is time consuming to produce by hand, and augment it in 
other metadata editing applications that support that profile. Examples of this are the USGS Metadata Wizard (FGDC) and the 
MdEditor (FGDC, ISO), among others. While in Catalog view, the Manage menu provides access to Import and Export tools 
to work with metadata outside of ArcGIS Pro.

Export Metadata can also exclude potentially sensitive information or machine names, so be sure to check your metadata 
thoroughly before exporting.

men22-7579_fig 01

Metadata can be imported from external files or datasets with the Import Metadata tool.

men22-7579_fig 01

https://usgs.github.io/fort-pymdwizard/index.html
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Appendix 3: Map Projections
Planetary researchers will encounter some quirks in planetary mapping, including the need to support positive west 

longitudes and geocentric (planetocentric) latitudes. Also, you may discover that many planetary bodies are defined as triaxial 
ellipsoids (using three radius values: sub-planetary equatorial, along-orbit equatorial, and polar axes). Fortunately, specifically 
defined to support planetary mapping, the International Astronomical Union (IAU) also commonly defines a best-fit mean 
radius. This simplifies the definition for the body to use a single spherical radius. Although, using a perfect sphere rather than 
an ellipsoid can increase surface distortions, it also greatly increases useability across different mapping applications. Spherical 
definitions are also often defined for very irregularly shaped bodies like asteroids or comets. To learn more about how the size 
of planetary bodies are defined, you can read more from the IAU Working Group on Cartographic Coordinates and Rotational 
Elements (WGCCRE, https://astrogeology.usgs.gov/groups/iau-wgccre).

When irregular bodies are not defined using a best-fit sphere, allowing for a simple map projection, ArcGIS Pro might not 
be able to suit your mapping needs. Fortunately, there are three-dimensional (3D)-enabled mapping applications being developed. 
For example, the interactive Small Body Mapping Tool (SBMT), created at Johns Hopkins University Applied Physics Laboratory, 
allow data, like the asteroid Eros, to be displayed within a 3D environment. For more see: http://sbmt.jhuapl.edu/.

The irregular shape of the asteroid Eros demonstrates how more typical map projections, meant to be used with ellipsoid 
or spherical bodies, will quickly break down. Once projected to a simple cylindrical (or other map projection) the data can be 
used in ArcGIS Pro. Note the original wavy grid-lines on the left will be snapped straight in simple cylindrical, often grossly 
distorting the image data underneath.

“Map of Eros.” Map of the asteroid 433 Eros created by Phil 
Stooke using images acquired by the NEAR Shoemaker 
spacecraft in 2000. U.S. Geological Survey, and Phil Stooke, 
University of Western Ontario, https://www.planetary.org/space-
images/map-of-eros.

men22-7579_fig 01 men22-7579_fig 01

In the planetary community, most printed maps have been based on conformal projections (angle preserving): Mercator 
for low latitudes, polar stereographic for high latitudes, Lambert conformal conic for intermediate latitudes at small scales, 
and transverse Mercator for large-scale maps. However, for modern digital products there is a trend to use very simple map 
projections to increase usability across mapping applications (also called data interoperability). Thus, we will often find 
global data sets released using the simple cylindrical map projection (also known as plate carrée, equidistant cylindrical, or 
equirectangular). Simple cylindrical uses an X,Y Cartesian plane in meters. You may also find data released in geographic/
geocentric which is really the same global rectangular shape as defined by simple cylindrical map projection, but it is defined 
in degrees. Because polar regions are grossly distorted in a simple cylindrical or using a degree-based projection, high-latitude 
products are also commonly released in a polar stereographic (meters) map projection for latitude ranges from ±~60° to 90°.

Without an additional plug-in (not yet available), ArcGIS Pro will not be able to display positive west longitudes. When 
using a recommended spherical radius, geocentric and geographic latitudes are the same. Use caution when using an ellipse 
defined using geocentric latitudes in ArcGIS Pro (or really any GIS application). Most applications will assume the data is 
defined using a geographic latitude system.

https://www.iau.org/
https://astrogeology.usgs.gov/groups/iau-wgccre
http://sbmt.jhuapl.edu/
https://www.planetary.org/space-images/map-of-eros
https://www.planetary.org/space-images/map-of-eros
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Loading Images Without a Projection Defined

While less common these days, users may find that a data set has no projection defined (or is not recognized by ArcGIS 
Pro). There are some steps one can take to still use the data, though caution should be taken. Let’s walk through a couple 
methods to define the needed geo-registration and map projection.

The recommended method is to execute this formatting outside of ArcGIS Pro using the free U.S. Geological Survey 
(USGS) Geospatial Data Abstraction Library (GDAL) utilities. As these utilities are now built-into ArcGIS Pro (as Python 
routines) we will show how they can also be used to accomplish this within ArcGIS Pro.

Method 1: Geospatial Data Abstraction Library (GDAL) Utilities
GDAL is a powerful library and is bundled with several useful utilities for any GIS user with data needs. GDAL has 

support for 100+ raster and 50+ vector-based formats. As a library, GDAL is also used in many GIS applications including 
ArcGIS Pro. For this task, we will use GDAL’s utility application gdal_translate.

GDAL utilities will require installation on your system outside of ArcGIS Pro. The easiest method to install GDAL utilities 
is within an Anaconda or Miniconda environment (supported on many different operating systems). Anaconda is a method 
to install independent working environments. It is often related to support Python-based environments but offers many other 
non-Python environments). To install Miniconda (a light-weight Anaconda installation, visit https://docs.conda.io/en/latest/
miniconda.html). Once Miniconda is installed, open a Miniconda terminal and type:

conda create -n gdal
conda activate gdal
conda install -c conda-forge gdal

To run any GDAL utility simply open a Miniconda terminal and “conda activate gdal”.

Now download an example image for Mars which does not have a map projection. https://www.mars.asu.edu/data/
mola_color/large/mola_color_N00_060.png (from the Arizona State University [ASU] website: https://www.mars.asu.edu/data/
mola_color/ ). This MOLA colorhillshade has the longitude range of 60 to 90° and latitude range of 0 to 30°.

We can either export this definition from ArcGIS Pro or simply create a new projection file with “Mars 200 Sphere” defined as.
File: Mars_2000_Sphere.prj

GEOGCS[“Mars_2000_(Sphere)”,DATUM[“Mars_2000_(Sphere)”,SPHEROID[“Mars_2000_(Sp
here)”,3396190.0,0.0]],PRIMEM[“Reference_Meridian”,0.0],UNIT[“Degree”,0.017453
2925199433],AUTHORITY[“Esri”,104971]]

Now let’s open our newly created Anaconda gdal environment and run:

gdal_translate -a_ullr 60 30 90 0 -a_srs “Mars_2000_Sphere.prj”
  -of GTIFF mola_color_N00_060.png mola_color_N00_060_ register.tif

So, what is this command doing? First, we are defining the extent in degrees using -a_ullr (upper left lon/lat and lower 
right lon/lat). Again, the longitude range for this image being 60 to 90° and latitude range of 0 to 30°. -a_srs loads the Mars 
2000 Sphere definition. This can be a file or a string. Here we are using degrees (not a true map projection in meters). To define 
this same image in simple cylindrical projection, the -a_ullr would need to be defined in X, Y coordinates in meters. Lastly, as 
GeoTIFF is the default output format, “-of GTIFF” is optional.

https://www.usgs.gov/node/280170
https://docs.conda.io/en/latest/miniconda.html
https://docs.conda.io/en/latest/miniconda.html
https://www.mars.asu.edu/data/mola_color/large/mola_color_N00_060.png
https://www.mars.asu.edu/data/mola_color/large/mola_color_N00_060.png
https://www.mars.asu.edu/data/mola_color/
https://www.mars.asu.edu/data/mola_color/
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Method 2: Using Geospatial Data Abstraction Library (GDAL) Inside ArcGIS Pro
While the GDAL library is used by ArcGIS Pro, the utility applications like gdal_translate are not included in the ArcGIS 

Pro installation. However, the utilities can also be accessed using Python calls. For available Python-wrapped GDAL utilities 
visit: https://gdal.org/python/osgeo.gdal-module.html#TranslateOptions.

From ArcGIS Pro’s Python window, type or copy and paste the following code. Note the path to the input and output file 
will need to be modified. Note the use of “\\” which helps with directory paths across all operating systems.

men22-7579_fig 01

The above Python will run exactly the same as the command-line utility shown above. Note the use of single quotes and 
double quotes in the Mars 2000 Sphere definition. Here we are using a multiple line string, but this can be pushed together as a 
one line (as shown above). For example.

out_srs = 
'GEOGCS[“Mars_2000_(Sphere)”,DATUM[“Mars_2000_(Sphere)”,SPHEROID 
[“Mars_2000_(Sphere)”,3396190.0,0.0]],PRIMEM[“Reference_Meridian”,0.0], 
UNIT[“Degree”,0.0174532925199433],AUTHORITY[“Esri”,104971]]’

Tip: to run multiple lines of code within the ArcGIS Pro Python window, use the combination of Control and enter buttons 
to run.

Map Projection Resources

There are many good resources available that allow you to dive further into map projections from both Esri and the 
mapping community. A few examples are listed below:

•	 Detailed coordinate system and projection information for ArcGIS Pro

•	 Geographic versus projected coordinate systems

•	 Choosing the right projection

•	 Video: Introduction to coordinate systems and map projections

•	 Story Map: Map projections

•	 Esri ArcGIS blog post on the Mercator projection

•	 USGS page of map projection posters and publications

•	 Fundamental Frameworks in Planetary Mapping: A Review (Hargitai and others, 2019)

https://pro.arcgis.com/en/pro-app/latest/help/mapping/properties/coordinate-systems-and-projections.htm
https://www.esri.com/arcgis-blog/products/arcgis-pro/mapping/gcs_vs_pcs/
https://learn.arcgis.com/en/projects/choose-the-right-projection/
https://www.esri.com/videos/watch?videoid=PICwxT0fTHQ&title=introducing-coordinate-systems-and-map-projections
https://storymaps.arcgis.com/stories/ea0519db9c184d7e84387924c84b703f
https://www.esri.com/arcgis-blog/products/arcgis-pro/mapping/mercator-its-not-hip-to-be-square/
https://www.researchgate.net/publication/331289441_Fundamental_Frameworks_in_Planetary_Mapping_A_Review
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